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git-cola(1)


SYNOPSIS

git cola [options] [sub-command]




DESCRIPTION

git cola is a sleek and powerful Git GUI.




OPTIONS


–amend

Start git cola in amend mode.




–prompt

Prompt for a Git repository.  Defaults to the current directory.




-r, –repo <path>

Open the Git repository at <path>.  Defaults to the current directory.




-s, –status-filter <filter>

Apply the path filter to the status widget.




–version

Print the git cola version and exit.




-h, –help

Show usage and optional arguments.




–help-commands

Show available sub-commands.






SUB-COMMANDS


am

Apply patches.




archive

Export tarballs from Git.




branch

Create branches.




browse

Browse tracked files.




config

Configure settings.




dag

Start the git dag Git history browser.




diff

Diff changed files.




fetch

Fetch history from remote repositories.




grep

Use git grep to search for content.




merge

Merge branches.




pull

Fetch and merge remote branches.




push

Push branches to remotes.




rebase

Start an interactive rebase.




remote

Create and edit remotes.




search

Search for commits.




stash

Stash uncommitted modifications.




tag

Create tags.




version

Print the git cola version.






CONFIGURE YOUR EDITOR

The editor used by Ctrl-e is configured from the Preferences screen.
The environment variable $VISUAL is consulted when no editor has been
configured.

ProTip: Configuring your editor to gvim -f -p will open multiple tabs
when editing files.  gvim -f -o uses splits.

git cola is {vim, emacs, textpad, notepad++}-aware.
When you select a line in the grep screen and press any of
Enter, Ctrl-e, or the Edit button, you are taken to that exact line.

The editor preference is saved in the gui.editor variable using
git config [http://git-scm.com/docs/git-config].




KEYBOARD SHORTCUTS

git cola has many useful keyboard shortcuts.

You can see the available shortcuts by pressing the ? key,
choosing Help -> Keyboard shortcuts from the main menu,
or by consulting the git cola keyboard shortcuts reference [https://git-cola.github.io/share/doc/git-cola/hotkeys.html].




TOOLS

The git cola interface is composed of various cooperating tools.
Double-clicking a tool opens it in its own subwindow.
Dragging it around moves and places it within the window.

Tools can be hidden and rearranged however you like.
git cola carefully remembers your window layout and restores
it the next time it is launched.

The Control-{1, 2, 3, …} hotkey gives focus to a specific tool.
A hidden tool can be re-opened using the Tools menu or
the Shift+Control-{1, 2, 3, …} shortcut keys.

The Diff editor can be focused with Ctrl-j.
the Status tool can be focused with Ctrl-k.
the Commit tool can be focused with Ctrl-l.




STATUS

The Status tool provides a visual analog to the
git status [http://git-scm.com/docs/git-status] command.

Status displays files that are modified relative to the staging area,
staged for the next commit, unmerged files from an in-progress merge,
and files that are untracked to git.

These are the same categories one sees when running
git status [http://git-scm.com/docs/git-status]
on the command line.

You can navigate through the list of files using keyboard arrows as well
as the ergonomical and vim-like j and k shortcut keys.

There are several convenient ways to interact with files in the Status tool.

Selecting a file displays its diff in the DIFF viewer.
Double-clicking a file stages its contents, as does the
the Ctrl-s shortcut key.

Ctrl-e opens selected files in the conifgured editor, and
Ctrl-d opens selected files using git difftool [http://git-scm.com/docs/git-difftool]

Additional actions can be performed using the right-click context menu.


Actions

Clicking the Staged folder shows a diffstat for the index.

Clicking the Modified folder shows a diffstat for the worktree.

Clicking individual files sends diffs to the Diff Display.

Double-clicking individual files adds and removes their content from the index.

Various actions are available through the right-click context menu.
Different actions are available depending a file’s status.


Stage Selected

Add to the staging area using git add [http://git-scm.com/docs/git-add]
Marks unmerged files as resolved.




Launch Editor

Launches the configured visual text editor




Launch Difftool

Visualize changes using git difftool.




Revert Unstaged Edits

Reverts unstaged content by checking out selected paths
from the index/staging area




Revert Uncommitted Edits

Throws away uncommitted edits




Unstage Selected

Remove from the index/staging area with
git reset [http://git-scm.com/docs/git-reset]




Launch Merge Tool

Resolve conflicts using git mergetool [http://git-scm.com/docs/git-mergetool].




Delete File(s)

Delete untracked files from the filesystem.




Add to .gitignore

Adds untracked files to to the .gitignore file.








DIFF

The diff viewer/editor displays diffs for selected files.
Additions are shown in green and removals are displayed in light red.
Extraneous whitespace is shown with a pure-red background.

Right-clicking in the diff provides access to additional actions
that use either the cursor location or text selection.


Staging content for commit

The @@ patterns denote a new diff hunk.  Selecting lines of diff
and using the Stage Selected Lines command will stage just the selected
lines.  Clicking within a diff hunk and selecting Stage Diff Hunk stages the
entire patch diff hunk.

The corresponding opposite commands can be performed on staged files as well,
e.g. staged content can be selectively removed from the index when we are
viewing diffs for staged content.






COMMIT MESSAGE EDITOR

The commit message editor is a simple text widget
for entering commit messages.

You can navigate between the Subject and Extended description…
fields using the keyboard arrow keys.

Pressing enter when inside the Subject field jumps down to the
extended description field.

The Options button menu to the left of the subject field
provides access to the additional actions.

The Ctrl+i keyboard shortcut adds a standard “Signed-off-by: ” line,
and Ctrl+Enter creates a new commit using the commit message and
staged content.


Sign Off

The Sign Off button adds a standard:

Signed-off-by: A. U. Thor <a.u.thor@example.com>





line to the bottom of the commit message.

Invoking this action is equivalent to passing the -s option
to git commit [http://git-scm.com/docs/git-commit].




Commit

The commit button runs
git commit [http://git-scm.com/docs/git-commit].
The contents of the commit message editor is provided as the commit message.

Only staged files are included in the commit – this is the same behavior
as running git commit on the command-line.




Line and Column Display

The current line and column number is displayed by the editor.
E.g. a 5,0 display means that the cursor is located at
line five, column zero.

The display changes colors when lines get too long.
Yellow indicates the safe boundary for sending patches to a mailing list
while keeping space for inline reply markers.

Orange indicates that the line is starting to run a bit long and should
break soon.

Red indicates that the line is running up against the standard
80-column limit for commit messages.

Keeping commit messages less than 76-characters wide is encouraged.
git log [http://git-scm.com/docs/git-log]
is a great tool but long lines mess up its formatting for everyone else,
so please be mindful when writing commit messages.




Amend Last Commit

Clicking on Amend Last Commit makes git cola amend the previous commit
instead of creating a new one.  git cola loads the previous commit message
into the commit message editor when this option is selected.

The Status tool will display all of the changes for the amended commit.




Create Signed Commit

Tell git commit and git merge to sign commits using GPG.

Using this option is equivalent to passing the --gpg-sign option to
git commit [http://git-scm.com/docs/git-commit] and
git merge [http://git-scm.com/docs/git-merge].

This option’s default value can be configured using the cola.signcommits
configuration variable.




Prepare Commit Message

The Commit -> Prepare Commit Message action or Ctrl-Shift-Return keyboard shortcut
runs the cola-prepare-commit-msg hook if it is available in .git/hooks/.
This is a git cola-specific hook that takes the same parameters
as Git’s prepare-commit-msg hook [https://git-scm.com/book/en/v2/Customizing-Git-Git-Hooks]

The hook is passed the path to .git/GIT_COLA_MSG as the first argument and the hook is expected to write
an updated commit message to specified path.  After running this action, the
commit message editor is updated with the new commit message.

To override the default path to this hook set the
cola.prepareCommitMessageHook git config variable to the path to the
hook script.  This is useful if you would like to use a common hook
across all repositories.






BRANCHES

The Branches tool provides a visual tree to navigate through the branches.
The tree has three main nodes Local Branch, Remote Branch and Tags.
Branches are grouped by their name divided by the character ‘/’.Ex:

branch/feature/foo
branch/feature/bar
branch/doe





Will produce:

branch
    - doe
    + feature
        - bar
        - foo





Current branch will display a star icon. If current branch has commits
ahead/behind it will display an up/down arrow with it’s number.


Actions

Various actions are available through the right-click context menu.
Different actions are available depending of selected branch status.


Checkout

The checkout action runs
git checkout [<branchname>] [https://git-scm.com/docs/git-checkout].




Merge in current branch

The merge action runs
git merge –no-commit [<branchname>] [https://git-scm.com/docs/git-merge].




Pull

The pull action runs
git pull –no-ff [<remote>] [<branchname>] [https://git-scm.com/docs/git-pull].




Push

The push action runs
git push [<remote>] [<branchname>] [https://git-scm.com/docs/git-push].




Rename Branch

The rename branch action runs
git branch -M [<branchname>] [https://git-scm.com/docs/git-push].




Delete Branch

The delete branch branch action runs
git branch -D [<branchname>] [https://git-scm.com/docs/git-branch].




Delete Remote Branch

The remote branch action runs
git push –delete [<remote>] [<branchname>] [https://git-scm.com/docs/git-push].








APPLY PATCHES

Use the File -> Apply Patches menu item to begin applying patches.

Dragging and dropping patches onto the git cola interface
adds the patches to the list of patches to apply using
git am [http://git-scm.com/docs/git-am].

You can drag either a set of patches or a directory containing patches.
Patches can be sorted using in the interface and are applied in the
same order as is listed in the list.

When a directory is dropped git cola walks the directory
tree in search of patches.  git cola sorts the list of
patches after they have all been found.  This allows you
to control the order in which patchs are applied by placing
patchsets into alphanumerically-sorted directories.




CUSTOM WINDOW SETTINGS

git cola remembers modifications to the layout and arrangement
of tools within the git cola interface.  Changes are saved
and restored at application shutdown/startup.

git cola can be configured to not save custom layouts by unsetting
the Save Window Settings option in the git cola preferences.




CONFIGURATION VARIABLES

These variables can be set using git config or from the settings.


cola.blameviewer

The command used to blame files.  Defaults to git gui blame.




cola.browserdockable

Whether to create a dock widget with the Browser tool.
Defaults to false to speedup startup time.




cola.checkconflicts

Inspect unmerged files for conflict markers before staging them.
This feature helps prevent accidental staging of unresolved merge conflicts.
Defaults to true.




cola.defaultrepo

git cola, when run outside of a Git repository, prompts the user for a
repository.  Set cola.defaultrepo to the path of a Git repository to make
git cola attempt to use that repository before falling back to prompting
the user for a repository.




cola.dictionary

Specifies an additional dictionary for git cola to use in its spell checker.
This should be configured to the path of a newline-separated list of words.




cola.expandtab

Expand tabs into spaces in the commit message editor.  When set to true,
git cola will insert a configurable number of spaces when tab is pressed.
The number of spaces is determined by cola.tabwidth.
Defaults to false.




cola.fileattributes

Enables per-file gitattributes encoding support when set to true.
This tells git cola to honor the configured encoding when displaying
and applying diffs.




cola.fontdiff

Specifies the font to use for git cola’s diff display.




cola.icontheme

Specifies the icon themes to use throughout git cola. The theme specified
must be the name of the subdirectory containing the icons, which in turn must
be placed in the inside the main “icons” directory in git cola’s
installation prefix.

If unset, or set either “light” or “default”, then the default style will be
used.  If set to “dark” then the built-in “dark” icon theme, which is
suitable for a dark window manager theme, will be used.

If set to an absolute directory path then icons in that directory will be used.
This value can be set to multiple values using,
git config –add cola.icontheme $theme.

This setting can be overridden by the GIT_COLA_ICON_THEME environment
variable, which can specify multiple themes using a colon-separated value.

The icon theme can also be specified by passing –icon-theme=<theme> on the
command line, once for each icon theme, in the order that they should be
searched.  This can be used to override a subset of the icons, and fallback
to the built-in icons for the remainder.




cola.inotify

Set to false to disable file system change monitoring.  Defaults to true,
but also requires either Linux with inotify support or Windows with pywin32
installed for file system change monitoring to actually function.




cola.refreshonfocus

Set to true to automatically refresh when git cola gains focus.  Defaults
to false because this can cause a pause whenever switching to git cola from
another application.




cola.linebreak

Whether to automatically break long lines while editing commit messages.
Defaults to true.  This setting is configured using the Preferences
dialog, but it can be toggled for one-off usage using the commit message
editor’s options sub-menu.




cola.maxrecent

git cola caps the number of recent repositories to avoid cluttering
the start and recent repositories menu.  The maximum number of repositories to
remember is controlled by cola.maxrecent and defaults to 8.




cola.dragencoding

git cola encodes paths dragged from its widgets into utf-16 when adding
them to the drag-and-drop mime data (specifically, the text/x-moz-url entry).
utf-16 is used to make gnome-terminal see the right paths, but other
terminals may expect a different encoding.  If you are using a terminal that
expects a modern encoding, e.g. terminator, then set this value to utf-8.




cola.readsize

git cola avoids reading large binary untracked files.
The maximum size to read is controlled by cola.readsize
and defaults to 2048.




cola.safemode

The “Stage” button in the git cola Actions panel stages all files when it is
activated and no files are selected.  This can be problematic if it is
accidentally triggered after carefully preparing the index with staged
changes.  “Safe Mode” is enabled by setting cola.safemode to true.
When enabled, git cola will do nothing when “Stage” is activated without a
selection.  Defaults to false.




cola.savewindowsettings

git cola will remember its window settings when set to true.
Window settings and X11 sessions are saved in $HOME/.config/git-cola.




cola.showpath

git cola displays the absolute path of the repository in the window title.
This can be disabled by setting cola.showpath to false.
Defaults to true.




cola.signcommits

git cola will sign commits by default when set true. Defaults to false.
See the section below on setting up GPG for more details.




cola.tabwidth

The number of columns occupied by a tab character.  Defaults to 8.




cola.terminal

The command to use when launching commands within a graphical terminal.

cola.terminal defaults to xterm -e when unset.
e.g. when opening a shell, git cola will run xterm -e $SHELL.

If either gnome-terminal, xfce4-terminal, or konsole are installed
then they will be preferred over xterm when cola.terminal is unset.




cola.textwidth

The number of columns used for line wrapping.
Tabs are counted according to cola.tabwidth.




cola.turbo

Set to true to enables “turbo” mode.  “Turbo” mode disables some
features that can slow things down when operating on huge repositories.
“Turbo” mode will skip loading Git commit messages, author details, status
information, and commit date details in the File Browser tool.
Defaults to false.




cola.color.text

The default diff text color, in hexadecimal #RRGGBB notation.
Defaults to “#030303”.




cola.color.add

The default diff “add” background color, in hexadecimal #RRGGBB notation.
Defaults to “#d2ffe4”.




cola.color.remove

The default diff “remove” background color, in hexadecimal #RRGGBB notation.
Defaults to “#fee0e4”.




cola.color.header

The default diff header text color, in hexadecimal #RRGGBB notation.
Defaults to “#bbbbbb”.




gui.diffcontext

The number of diff context lines to display.




gui.displayuntracked

git cola avoids showing untracked files when set to false.




gui.editor

The default text editor to use is defined in gui.editor.
The config variable overrides the VISUAL environment variable.
e.g. gvim -f -p.




gui.historybrowser

The history browser to use when visualizing history.
Defaults to gitk.




diff.tool

The default diff tool to use.




merge.tool

The default merge tool to use.




user.email

Your email address to be recorded in any newly created commits.
Can be overridden by the ‘GIT_AUTHOR_EMAIL’, ‘GIT_COMMITTER_EMAIL’, and
‘EMAIL’ environment variables.




user.name

Your full name to be recorded in any newly created commits.
Can be overridden by the ‘GIT_AUTHOR_NAME’ and ‘GIT_COMMITTER_NAME’
environment variables.






ENVIRONMENT VARIABLES


GIT_COLA_ICON_THEME

When set in the environment, GIT_COLA_ICON_THEME overrides the
theme specified in the cola.icontheme configuration.
Read the section on cola.icontheme above for more details.




GIT_COLA_SCALE

git cola can be made to scale its interface for HiDPI displays.
When defined, git cola will scale icons, radioboxes, and checkboxes
according to the scale factor.  The default value is 1.
A good value is 2 for high-resolution displays.

Fonts are not scaled, as their size can already be set in the settings.




GIT_COLA_TRACE

When defined, git cola logs git commands to stdout.
When set to full, git cola also logs the exit status and output.
When set to trace, git cola logs to the Console widget.




VISUAL

Specifies the default editor to use.
This is ignored when the gui.editor configuration variable is defined.






LANGUAGE SETTINGS

git cola automatically detects your language and presents some
translations when available.  This may not be desired, or you
may want git cola to use a specific language.

You can make git cola use an alternative language by creating a
~/.config/git-cola/language file containing the standard two-letter
gettext language code, e.g. “en”, “de”, “ja”, “zh”, etc.:

mkdir -p ~/.config/git-cola &&
echo en >~/.config/git-cola/language





Alternatively you may also use LANGUAGE environmental variable to temporarily
change git cola’s language just like any other gettext-based program.  For
example to temporarily change git cola’s language to English:

LANGUAGE=en git cola





To make git cola use the zh_TW translation with zh_HK, zh, and en as a
fallback.:

LANGUAGE=zh_TW:zh_HK:zh:en git cola








CUSTOM GUI ACTIONS

git cola allows you to define custom GUI actions by setting git config
variables.  The “name” of the command appears in the “Actions” menu.


guitool.<name>.cmd

Specifies the shell command line to execute when the corresponding item of the
Tools menu is invoked. This option is mandatory for every tool. The command is
executed from the root of the working directory, and in the environment it
receives the name of the tool as GIT_GUITOOL, the name of the currently
selected file as FILENAME, and the name of the current branch as CUR_BRANCH
(if the head is detached, CUR_BRANCH is empty).




guitool.<name>.background

Run the command in the background (similar to editing and difftool actions).
This avoids blocking the GUI.  Setting background to true implies
noconsole and norescan.




guitool.<name>.needsfile

Run the tool only if a diff is selected in the GUI. It guarantees that
FILENAME is not empty.




guitool.<name>.noconsole

Run the command silently, without creating a window to display its output.




guitool.<name>.norescan

Don’t rescan the working directory for changes after the tool finishes
execution.




guitool.<name>.confirm

Show a confirmation dialog before actually running the tool.




guitool.<name>.argprompt

Request a string argument from the user, and pass it to the tool through the
ARGS environment variable. Since requesting an argument implies confirmation,
the confirm option has no effect if this is enabled. If the option is set to
true, yes, or 1, the dialog uses a built-in generic prompt; otherwise the
exact value of the variable is used.




guitool.<name>.revprompt

Request a single valid revision from the user, and set the REVISION
environment variable. In other aspects this option is similar to argprompt,
and can be used together with it.




guitool.<name>.revunmerged

Show only unmerged branches in the revprompt subdialog. This is useful for
tools similar to merge or rebase, but not for things like checkout or reset.




guitool.<name>.title

Specifies the title to use for the prompt dialog.
Defaults to the tool name.




guitool.<name>.prompt

Specifies the general prompt string to display at the top of the dialog,
before subsections for argprompt and revprompt.
The default value includes the actual command.




guitool.<name>.shortcut

Specifies a keyboard shortcut for the custom tool.

The value must be a valid string understood by the QAction::setShortcut() API.
See http://qt-project.org/doc/qt-4.8/qkeysequence.html#QKeySequence-2
for more details about the supported values.

Avoid creating shortcuts that conflict with existing built-in git cola
shortcuts.  Creating a conflict will result in no action when the shortcut
is used.






SETTING UP GPG FOR SIGNED COMMITS

When creating signed commits gpg will attempt to read your password from the
terminal from which git cola was launched.
The way to make this work smoothly is to use a GPG agent so that you can avoid
needing to re-enter your password every time you commit.

This also gets you a graphical passphrase prompt instead of getting prompted
for your password in the terminal.


Install gpg-agent and friends

On Mac OS X, you may need to brew install gpg-agent and install the
Mac GPG Suite [https://gpgtools.org/macgpg2/].

On Linux use your package manager to install gnupg2,
gnupg-agent and pinentry-qt, e.g.:

sudo apt-get install gnupg2 gnupg-agent pinentry-qt





On Linux, you should also configure Git so that it uses gpg2 (gnupg2),
otherwise you will get errors mentioning, “unable to open /dev/tty”.
Set Git’s gpg.program to gpg2:

git config --global gpg.program gpg2








Configure gpg-agent and a pin-entry program

On Mac OS X, edit ~/.gnupg/gpg.conf to include the line,:

use-agent





This is typically not needed on Linux, where gpg2 is used, as
this is the default value when using gpg2.

Next, edit ~/.gnupg/gpg-agent.conf to contain a pinentry-program line
pointing to the pinentry program for your platform.

The following example ~/.gnupg/gpg-agent.conf shows how to use
pinentry-gtk-2 on Linux:

pinentry-program /usr/bin/pinentry-gtk-2
default-cache-ttl 3600





This following example .gnupg/gpg-agent.conf shows how to use MacGPG2’s
pinentry app on On Mac OS X:

pinentry-program /usr/local/MacGPG2/libexec/pinentry-mac.app/Contents/MacOS/pinentry-mac
default-cache-ttl 3600
enable-ssh-support
use-standard-socket





Once this has been setup then you will need to reload your gpg-agent config.:

echo RELOADAGENT | gpg-connect-agent





If you see the following output:

OK





Then the daemon is already running, and you do not need to start it yourself.

If it is not running, eval the output of gpg-agent –daemon in your shell
prior to launching git cola.:

eval $(gpg-agent --daemon)
git cola










WINDOWS NOTES


Git Installation

If Git is installed in a custom location, e.g. not installed in C:/Git or
Program Files, then the path to Git must be configured by creating a file in
your home directory ~/.config/git-cola/git-bindir that points to your git
installation.  e.g.:

C:/Tools/Git/bin










LINKS


Git Cola’s Git Repository

https://github.com/git-cola/git-cola/




Git Cola Homepage

https://git-cola.github.io/




Mailing List

https://groups.google.com/group/git-cola









          

      

      

    

  

    
      
          
            
  
git-dag(1)


SYNOPSIS

git dag [options] [<since>..<until>] [[–] [<path>…]]




DESCRIPTION

git-dag is a powerful Git history visualizer.
git-dag presents powerful git log features in a simple-to-use
graphical interface.




OPTIONS


–prompt

Prompt for a Git repository instead of using the current directory.




-r, –repo <path>

Run git dag on the git repository in <path>.
Defaults to the current directory.




–version

Print the git dag version and exit.




-h, –help

Show usage and optional arguments.






Log Options

The Log prompt allows you to pass arguments to git log.
This can be used to filter the displayed history, for example
entering master – Makefile will display only commits on the
master branch that touch the Makefile.




CONTEXT-MENU ACTIONS

The right-click menu can be used to perform various actions.
All actions operate on the selected commit.

You can create branches and tags, cherry-pick commits, save patches,
export tarballs, and grab files from older commits using the context menu.




DIFF COMMITS

You can diff arbitrary commits.  Select a single commit in either the list
view or the graph view and then right-click on a second commit.

A menu will appear allowing you to diff the two commits.




SHORTCUTS

You can run commands using dedicated shortcuts. Select a single commit
and then press Ctrl-Alt-c to copy sha1 or Ctrl-d to run diff tool.

You can read more about hotkeys from ‘keyboard shortcuts’ window or context menu.




CONFIGURATION VARIABLES


log.date

Set the default date-time format for the ‘Date’ field.
Setting a value for log.date is similar to using git log’s
–date option.  Possible values are relative, local,
default, iso, rfc, and short; see git-log(1) for details.
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Releases


Latest Release

v3.2 is the latest stable release.




Development version

Clone the git-cola repo to get the latest development version:

git clone git://github.com/git-cola/git-cola.git




git-cola v3.2


Usability, bells and whistles


	The git cola dag DAG window now supports git revert.

https://github.com/git-cola/git-cola/issues/843



	git stash pop is now supported by the stash dialog.

https://github.com/git-cola/git-cola/issues/844



	The status widget now ensures that each item is visible when selection
changes.  Previously, if you scrolled to the right to see the name of
a long filename, and then selected a short filename above it, the widget
may not have shown the short filename in the viewport.  We now ensure
that the filenames are visible when the selection changes.

https://github.com/git-cola/git-cola/pull/828



	The git xbase rebase editor no longer displays an error when
cancelling an interactive rebase.

https://github.com/git-cola/git-cola/issues/814



	The dialog shown when renaming remotes has been simplified.

https://github.com/git-cola/git-cola/pull/840

https://github.com/git-cola/git-cola/issues/838



	The help dialog in the git-xbase Rebase editor is now scrollable.

https://github.com/git-cola/git-cola/issues/855








Translations


	Updated Brazilian translation

https://github.com/git-cola/git-cola/pull/845



	Updated Czech translation

https://github.com/git-cola/git-cola/pull/854

https://github.com/git-cola/git-cola/pull/853

https://github.com/git-cola/git-cola/pull/835

https://github.com/git-cola/git-cola/pull/813



	Update Spanish translation

https://github.com/git-cola/git-cola/pull/862

https://github.com/git-cola/git-cola/pull/867








Packaging


	The original #!/usr/bin/env python shebang lines can now be
retained by passing USE_ENV_PYTHON=1 to make when installing.

https://github.com/git-cola/git-cola/issues/850



	The Makefile is now resilient to DESTDIR and prefix containing whitespace.

https://github.com/git-cola/git-cola/pull/858



	The vendored qtpy library was updated to v1.4.2.


	python3-distutils is needed to build cola on Debian.

https://github.com/git-cola/git-cola/issues/837








Fixes


	The “C” key no longer closes the message dialogs, for example the
one that is shown when a commit fails its pre-commit hooks.
This allows “Ctrl+C” copy to work, rather than closing the dialog.

https://github.com/git-cola/git-cola/issues/734



	Dock widgets sizes are now properly saved and restored when the main
window is maximized.

https://github.com/git-cola/git-cola/issues/848



	The spellcheck feature was broken under Python3.

https://github.com/git-cola/git-cola/issues/857



	A regression when saving stashes was fixed.

https://github.com/git-cola/git-cola/issues/847



	Diffing image files was not updating the available context menus,
which prevented the “Stage” action from being present in the menu.

https://github.com/git-cola/git-cola/issues/841



	git cola now detects when git lfs uninstall has been run.  This allows
you to re-initialize “Git LFS” in an existing repository where it had been
previously uninstalled.

https://github.com/git-cola/git-cola/issues/842



	Custom color values that did not contain any hexadecimal digits in the
a-f range were being converted into integers by the config reader.  This
then caused the configured colors to be ignored.

These color values are now interpreted correctly.  Additionally, color
values can now use an optional HTML-like # prefix.

Example .gitconfig snippet:

[cola "color"]
    text = "#0a0303"





https://github.com/git-cola/git-cola/pull/836

https://github.com/git-cola/git-cola/issues/849



	We now display an error message graphically when Git is not installed.
Previously, the message went to stderr only.

https://github.com/git-cola/git-cola/issues/830



	Changing diff options was causing resulting in an exception.

https://github.com/git-cola/git-cola/issues/833

https://github.com/git-cola/git-cola/pull/834



	The DAG window now updates itself when branches and tags are created.

https://github.com/git-cola/git-cola/issues/814



	The user’s $PATH environment variable can now contain utf-8
encoded paths.  Previously, launching external commands could
lead to tracebacks.

https://github.com/git-cola/git-cola/issues/807



	Git Cola development sandboxes can now be stored on utf-8 encoded
filesystem paths.  Previously, the interactive rebase feature
could be broken when running in that environment.

https://github.com/git-cola/git-cola/issues/825



	The log window now uses an ISO-8601 timestamp, which
avoids localized output in the log window.

https://github.com/git-cola/git-cola/issues/817








Development


	The code base has been thoroughly sanitized using pylint, and
travis is now running pylint over the entire project.


	Miscellaneous improvements and code improvements.

https://github.com/git-cola/git-cola/issues/874










git-cola v3.1


Usability, bells and whistles


	The “Browser” widget learned to rename files using “git mv”.

https://github.com/git-cola/git-cola/issues/239



	The “Diff” widget learned to diff images.  Side-by-side and pixel diff
modes allow you to inspect changes to common images formats.

https://github.com/git-cola/git-cola/issues/444

https://github.com/git-cola/git-cola/pull/803



	Git LFS and Git Annex are natively supported by the image diff viewer.


	Git Annex operations are now included. git annex init can be performed on
repositories, and git annex add can be run on untracked files from the
status widget.  Install git-annex to activate this feature.


	Git LFS operations are now included. git lfs install can be performed on
repositories, and git lfs track can be run on untracked files from the
status widget.  Install git-lfs to activate this feature.


	The “Stash” tool learned to stash staged changes only.  Select the
“Stage Index” option and only staged changes will be stashed away.

https://github.com/git-cola/git-cola/issues/413



	The “Stash” tool learned to use vim-like navigation keyboard shortcuts,
shows error messages when things go wrong, and now saves the “Stash Index”
and “Keep Index” options across sessions.


	The Edit menu’s “Copy” and “Select All” actions now forward to either the
diff, status, recent, or favorites widgets, based on which widget has focus.


	The “File” and “Edit” menu can now be activated using Alt-{f,e} hotkeys.

https://github.com/git-cola/git-cola/issues/759



	It was easy to accidentally trigger the first action in the Status tool’s
context menu when using a quick right-click to bring up the menu.
A short sub-second delay was added to ensure that the top-most action is not
triggered unless enough time has passed.  This prevents accidental
activation of the first item (typically “Stage” or “Unstage”) without
burdening common use cases.

https://github.com/git-cola/git-cola/pull/755

https://github.com/git-cola/git-cola/issues/643



	The “Ctrl+S” hotkey now works for the header items in the Status tool.
Selected the “Modified” header item and activating the “Stage” hotkey,
for example, will stage all modified files.  This works for the “Staged”,
“Modified”, and “Untracked” headers.  This is not enabled for the
“Unmerged” header by design.

https://github.com/git-cola/git-cola/issues/772



	The list of “Recent” repositories previously capped the number of
repositories shown to 8 repositories.  This can be set to a higher
value by setting the cola.maxrecent configuration variable.

https://github.com/git-cola/git-cola/issues/752



	The “Create Branch” dialog now prevents invalid branch names.

https://github.com/git-cola/git-cola/issues/765



	Updated Turkish translation.

https://github.com/git-cola/git-cola/pull/756



	Updated Ukrainian translation.

https://github.com/git-cola/git-cola/pull/753



	Updated German translation.

https://github.com/git-cola/git-cola/pull/802



	Updated Czech translation

https://github.com/git-cola/git-cola/pull/792

https://github.com/git-cola/git-cola/pull/806



	The window title can be configured to not display the absolute path of the
repository.

https://github.com/git-cola/git-cola/issues/775



	The “Edit Remotes” editor learned to edit remote URLS.


	Bare repositories can now be created by selecting the
“New Bare Repository…” action from the File menu.


	The “Branches” widget learned to configure upstream branches.


	A new git cola clone sub-command was added for cloning repositories.







Packaging


	The vendored qtpy library was updated to v1.3.1.


	The macOS installation was made simpler for better compatibility with
Homebrew.

https://github.com/git-cola/git-cola/issues/636



	The Windows installer is now much simpler.  Git Cola now bundles
Python and PyQt5, so users need only install the “Git for Windows”
and “Git Cola” installers to get things working.







Fixes


	Uninitialized difftool errors will now be displayed graphically.
They were previously going to the shell.

https://github.com/git-cola/git-cola/issues/457



	Translations marked “fuzzy” will no longer be used when translating strings.

https://github.com/git-cola/git-cola/issues/782



	Deleted unmerged files will now correctly use a deleted icon.

https://github.com/git-cola/git-cola/issues/479



	The Ctrl+C “Copy” hotkey on the diff viewer has been fixed.

https://github.com/git-cola/git-cola/issues/767



	The “Create Tag” dialog did not correctly handle the case when a signed
tag is requested, but no message is provided, and the user chooses to
create an unannotated tag instead.  This convenience fallback will now
properly create an unsigned, unannotated tag.

https://github.com/git-cola/git-cola/issues/696



	.gitconfig and .git/config values editable by the Preferences dialog
(aka git cola config) will now get unset when set to an empty value.
For example, setting a different user.email in the current repository,
followed by a subsequent emptying of that field, would previously result in
an empty string getting stored in the config.  This has been fixed so that
the value will now get unset in the config instead.

https://github.com/git-cola/git-cola/issues/406



	Spelling and typofixes.

https://github.com/git-cola/git-cola/pull/748



	core.commentChar is now honored when set in the local repository
.git/config.

https://github.com/git-cola/git-cola/issues/766



	The log window was using a format string that did not display
correctly in all locales.  A locale-aware format is now used.

https://github.com/git-cola/git-cola/pull/800



	The dialog displayed when prompting for a reference could sometimes
lose focus.

https://github.com/git-cola/git-cola/pull/804










git-cola v3.0


Usability, bells and whistles


	Updated Simplified Chinese translation.

https://github.com/git-cola/git-cola/pull/726



	Updated Ukrainian translation.

https://github.com/git-cola/git-cola/pull/723



	New Czech translation.

https://github.com/git-cola/git-cola/pull/736

https://github.com/git-cola/git-cola/pull/737

https://github.com/git-cola/git-cola/pull/740

https://github.com/git-cola/git-cola/pull/743



	The “name” field in the “Create Tag” dialog now includes autocompletion,
which makes it easy to see which tags currently exist.


	git cola now has configurable toolbars.  Use the View -> Add toolbar
menu item to add a toolbar.


	Setting cola.expandtab to true will now expand tabs into spaces
in the commit message editor.  The number of spaces to insert is determined
by consulting cola.tabwidth, which defaults to 8.


	The “Copy SHA-1” hotkey is now Alt + Ctrl + C, to avoid clobbering the
ability to copy text from the DAG window.

https://github.com/git-cola/git-cola/pull/705



	The “Prepare Commit Message” action can now be invoked via the
Ctrl+Shift+Return shortcut.

https://github.com/git-cola/git-cola/pull/707



	The Branches pane now has a filter field that highlights branches whose
names match the string entered into its text field.

https://github.com/git-cola/git-cola/pull/713



	Actions that are triggered in response to button presses were being
triggered when the button was pressed, rather than when it was released,
which was a usability flaw.  All buttons now respond when clicked
rather than when pressed.

https://github.com/git-cola/git-cola/pull/715



	The DAG window will now only refresh when object IDs change.
Previously, the DAG would redraw itself in response to inotify events,
such as filesystem operations, which was disruptive when inspecting a large
diff in its diff viewer.  The DAG will now only redraw when the object IDs
corresponding to its query input changes.  Furthermore, when redrawing, the
scrollbar positions are retained to minimize disruption to the viewport
contents.

https://github.com/git-cola/git-cola/issues/620

https://github.com/git-cola/git-cola/issues/724



	The “About” dialog now includes the SHA-1 where Git Cola was built.

https://github.com/git-cola/git-cola/issues/530



	The “Status” widget now has “Copy Leading Path to Clipboard” and
“Copy Basename to Clipboard” actions.

https://github.com/git-cola/git-cola/issues/435

https://github.com/git-cola/git-cola/issues/436



	The “Status” widget now supports custom “Copy … to Clipboard” actions.

https://github.com/git-cola/git-cola/issues/437



	The main menu now has an “Edit” menu.

https://github.com/git-cola/git-cola/issues/725



	git dag learned to checkout commits into a detached HEAD state.

https://github.com/git-cola/git-cola/issues/698



	The status widget’s context menus now omit actions selection-dependent
actions when no file is selected.

https://github.com/git-cola/git-cola/pull/731



	The startup dialog now focuses the repository list so that repositories
can be selected with the keyboard without mouse intervention.

https://github.com/git-cola/git-cola/issues/741








Fixes


	git dag now prevents nodes from overlapping in more situations.

https://github.com/git-cola/git-cola/pull/689



	Adding untracked Git submodule repo directories previously ran
git add submodule/ but we now call git add submodule without
the trailing slash (/) to avoid staging files that belong to the
submodule (which is possibly a git bug).  By working around the
buggy behavior we allow users to recover by issuing the appropriate
git submodule add command to properly register the submodule.

https://github.com/git-cola/git-cola/pull/681



	We now avoid git for-each-ref –sort=version:refname on versions
of git older than v2.7.0.  Previously we only avoided it for
versions older than v2.0.0, which was a mistake.

https://github.com/git-cola/git-cola/pull/686



	The error message displayed when git is not installed has been fixed.

https://github.com/git-cola/git-cola/pull/686



	Adding new remotes was silently broken.

https://github.com/git-cola/git-cola/issues/684

https://github.com/git-cola/git-cola/pull/685



	The repo selection dialog had errors during startup when the
cola.refreshonfocus feature was enabled, as reported on Ubuntu 16.04.

https://github.com/git-cola/git-cola/issues/690



	Restored support for PyQt 4.6 (Centos 6.8)

https://github.com/git-cola/git-cola/issues/692



	Switching repositories now resets the “Amend Mode” and other settings
when switching.

https://github.com/git-cola/git-cola/issues/710



	git rebase error messages now displayed when rebasing fails or stops
via the standalone git cola rebase front-end.

https://github.com/git-cola/git-cola/issues/721



	git cola learned to stage broken symlinks.

https://github.com/git-cola/git-cola/issues/727



	The “View History” feature in the Browser tool was fixed, and now
disambiguates between refs and paths.

https://github.com/git-cola/git-cola/issues/732



	The diff editor now has better support for files with CRLF rn
line endings.

https://github.com/git-cola/git-cola/issues/730



	cola.inotify in a repo-local config is now honored
when git cola is launched from a desktop entry (git cola –prompt).

https://github.com/git-cola/git-cola/issues/695










git-cola v2.11


Usability, bells and whistles


	New Ukrainian translation.

https://github.com/git-cola/git-cola/pull/670

https://github.com/git-cola/git-cola/pull/672



	New and improved French translations.


	The new Branches widget makes it easier to checkout, merge, push,
and pull branches from a single interface.


	git cola now includes a dark icon theme.  The dark icon theme can be
activated either by setting the GIT_COLA_ICON_THEME environment variable
to dark, by configuring cola.icontheme to dark, or by specifying
–icon-theme=dark on the command line.

https://github.com/git-cola/git-cola/pull/638



	Autocompletion was added to the Fetch, Push, and Pull dialogs.


	The commit message editor now remembers the “Spellcheck” setting
after exiting.

https://github.com/git-cola/git-cola/pull/645



	git dag now uses an improved algorithm for laying out the graph,
which avoids collisions under certain graph configurations, and
avoids overlapping tag with commits.

https://github.com/git-cola/git-cola/pull/648

https://github.com/git-cola/git-cola/pull/651

https://github.com/git-cola/git-cola/pull/654

https://github.com/git-cola/git-cola/pull/656

https://github.com/git-cola/git-cola/pull/659



	git dag now remembers its column sizes across sessions.

https://github.com/git-cola/git-cola/issues/674



	Grep now shows a preview of the selected file’s content in a split window
below the grep results.


	Grep now includes line numbers in the preview pane’s output.


	Edit Remotes now remembers its window settings after exiting.


	Diff now has an option to display line numbers in the editor.

https://github.com/git-cola/git-cola/issues/136



	Amend Last Commit can now be triggered via the Commit menu in addition
to the commit message editor’s options.

https://github.com/git-cola/git-cola/issues/640



	The File Browser tool was made much faster and can now operate on
much larger repositories.

https://github.com/git-cola/git-cola/issues/499



	A new “turbo” mode was added that allows you to opt-out of operations
that can slow git cola on large repositories.  The turbo mode is
enabled by configuring git config cola.turbo true.  Turbo mode
disables the background loading of Git commit messages and other
details in the File Browser widget.


	A new GitIgnore dialog allows adding custom gitignore patterns.

https://github.com/git-cola/git-cola/pull/653



	The spellchecker in git cola can now use an additional dictionary
by configuring cola.dictionary to the path to a file containing
a newline-separated list of words.

https://github.com/git-cola/git-cola/issues/663



	The stash, export patches, diff, and gitignore dialogs now remember
their window sizes.


	A new git cola recent sub-command was added for finding recently
edited files.


	The Fetch dialog now allows pruning remote branches.

https://github.com/git-cola/git-cola/issues/639

https://github.com/git-cola/git-cola/pull/680








Fixes


	git cola’s spellchecker now supports the new dict-common filesystem
layout, and prefers the /usr/share/dict/cracklib-small file over the
/usr/share/dict/words provided on older distributions.
This makes the spellchecker compatible with Arch, which does not provide
a words symlink like Debian.

https://github.com/git-cola/git-cola/issues/663



	Properly handle the case where an existing file is untracked using
the File Browser.


	Fix a quirk where the “Create Branch” dialog sometimes required clicking
twice on the radio buttons.

https://github.com/git-cola/git-cola/pull/662



	Fixed a focus issue to ensure that “Push”, “Fetch”, and “Pull” can
be executed with the press of a single enter key after being shown.

https://github.com/git-cola/git-cola/issues/661



	Committing is now allowed in when resolving a merge results in no
changes.  This state was previously prevented by the commit message editor,
which prevented users from resolving merges that result in no changes.

https://github.com/git-cola/git-cola/pull/679



	The filesystem monitor would sometimes emit backtraces when directories
are modified.  This has been fixed.

https://bugzilla.redhat.com/show_bug.cgi?id=1438522



	Absolute paths are now returned when querying for .git-relative paths
from within a submodule, which uses .git-files.
This fixes launching git cola from within a subdirectory of a submodule.

https://github.com/git-cola/git-cola/pull/675










git-cola v2.10


Usability, bells and whistles


	git cola can now invoke the .git/hooks/cola-prepare-commit-msg
hook to update the commit message.  This hook takes the same parameters
as Git’s prepare-commit-message hook.  The default path to this hook
can be overridden by setting the cola.prepareCommitMessageHook
configuration variable.

http://git-cola.readthedocs.io/en/latest/git-cola.html#prepare-commit-message



	git cola diff (and the corresponding Diff menu actions) can now
launch difftool with the standard Ctrl+D hotkey.  The Ctrl+E hotkey was
also added for launching an editor.


	Traditional Chinese (Taiwan) translation updates.







Fixes


	git cola now works when installed in non-ascii, utf8-encoded paths.

https://github.com/git-cola/git-cola/issues/629



	Styling issues that caused black backgrounds in various widgets when using
PyQ5 on Mac OS X have been fixed.

https://github.com/git-cola/git-cola/issues/624



	The “Open Recent” menu action was broken and has been fixed.

https://github.com/git-cola/git-cola/issues/634



	Exiting git cola with a maximized main window would hang when reopened
on Linux.

https://github.com/git-cola/git-cola/issues/641








Packaging


	appdata.xml files are now provided at
share/appdata/git-cola.xml and share/appdata/git-dag.xml
for use by the Linux software gallery.

https://people.freedesktop.org/~hughsient/appdata/

https://github.com/git-cola/git-cola/pull/627










git-cola v2.9.1


Fixes


	The “Open Recent” menu was updated to new bookmarks format.

https://github.com/git-cola/git-cola/issues/628










git-cola v2.9


Usability, bells and whistles


	New Polish translation thanks to Łukasz Wojniłowicz

https://github.com/git-cola/git-cola/pull/598



	The Bypass Commit Hooks feature now disables itself automatically
when a new commit is created.  The new behavior turns the option into a
single-use flag, which helps prevent users from accidentally leaving it
active longer than intended.

https://github.com/git-cola/git-cola/pull/595



	git dag learned to launch an external diff viewer on selected commits.
The standard Ctrl+D shortcut can be used to view diffs.

https://github.com/git-cola/git-cola/issues/468



	git dag learned to launch directory diffs via git difftool –dir-diff.
The Ctrl+Shift+D shortcut launches difftool in directory-diff mode.

https://github.com/git-cola/git-cola/issues/468



	Items in the “Favorites” list can now be renamed, which makes it
easier to differentiate between several checkouts of the same repository.

https://github.com/git-cola/git-cola/issues/599

https://github.com/git-cola/git-cola/pull/601



	The startup screen now includes a logo and git cola version information.

https://github.com/git-cola/git-cola/issues/526



	The About page was revamped to contain multiple tabs.  A new tab was added
that provides details about git cola’’s dependencies.  New tabs were also
added for giving credit to git cola’s authors and translators.


	The About page can now be accessed via git cola about.


	The “Fast-forward only” and “No fast-forward” options supported by
git pull are now accessible via git cola pull.


	Doing a forced push no longer requires selecting the remote branch.

https://github.com/git-cola/git-cola/pull/618



	git cola push now has an option to suppress the prompt that is shown
when pushing would create new remote branches.

https://github.com/git-cola/git-cola/issues/605



	git dag now shows commit messages in a more readable color.

https://github.com/git-cola/git-cola/issues/574



	git cola browse and the status widget learned to launch the OS-specified
default action for a file.  When used on directories via git cola browse,
or when “Open Parent Directory” is used on files, the OS-specified
file browser will typically be used.


	git cola browse and the status widget learned to launch terminals.







Fixes


	git cola browse was not updating when expanding items.

https://github.com/git-cola/git-cola/issues/588



	Typofixes in comments, naming, and strings have been applied.

https://github.com/git-cola/git-cola/pull/593



	The inotify and win32 filesystem monitoring no longer refreshes
when updates are made to ignored files.

https://github.com/git-cola/git-cola/issues/517

https://github.com/git-cola/git-cola/issues/516



	The Refresh button on the actions panel no longer raises an
exception when using PyQt5.

https://github.com/git-cola/git-cola/issues/604



	Fixed a typo in the inotify backend that is triggered when files are removed.

https://github.com/git-cola/git-cola/issues/607



	Fixed a typo when recovering from a failed attempt to open a repository.

https://github.com/git-cola/git-cola/issues/606



	git dag now properly updates itself when launched from the menubar.

https://github.com/git-cola/git-cola/pull/613



	If git-cola is invoked on Windows using start pythonw git-cola,
a console window will briefly flash on the screen each time
git cola invokes git.  The console window is now suppressed.


	We now avoid some problematic Popen flags on Windows which were
breaking the git rebase feature on Windows.


	The Save button in git dag’s “Grab File…” feature now properly
prompts for a filename when saving files.

https://github.com/git-cola/git-cola/pull/617








Development


	The qtpy symlink in the source tree has been removed to allow for easier
development on Windows.

https://github.com/git-cola/git-cola/issues/626










git-cola v2.8


Usability, bells and whistles


	git cola push learned to configure upstream branches.

https://github.com/git-cola/git-cola/issues/563








Fixes


	The diffstat view is now properly updated when notifications are
received via inotify filesystem monitoring.

https://github.com/git-cola/git-cola/issues/577



	Python3 with PyQt5 had a bug that prevented git cola from starting.

https://github.com/git-cola/git-cola/pull/589










git-cola v2.7


Fixes


	When repositories stored in non-ASCII, UTF-8-encoded filesystem paths
were operated upon with LC_ALL=C set in the environment, unicode errors
would occur when using python2.  git cola was made more robust and will
now operate correctly within this environment.

https://github.com/git-cola/git-cola/issues/581



	Support for the GIT_WORK_TREE environment variable was fixed.

https://github.com/git-cola/git-cola/pull/582








Development


	The unittest.mock module is now used instead of the original mock module
when running the git cola test suite using Python3.

https://github.com/git-cola/git-cola/issues/569








Packaging


	git cola is now compatible with PyQt5, PyQt4, and Pyside.
git cola previously supported PyQt4 only, but will now use whichever
library is available.  Users are not required to upgrade at this time,
but PyQt5 support can be enabled anytime by making its python
modules available.

https://github.com/git-cola/git-cola/issues/232

NOTE: We do not yet recommend using PyQt5 because there are known
exit-on-segfault bugs in Qt5 that have not yet been addressed.
git cola is sensitive to this bug and is known to crash on exit
when using git dag or the interactive rebase feature on PyQt5.

https://bugreports.qt.io/browse/QTBUG-52988

PyQt4 is stable and there are no known issues when using it so
we recommend using it until the Qt5 bugs have been resolved.



	git cola now depends on QtPy and includes a bundled copy of the
qtpy library.  If you are packaging git cola and would prefer to use
qtpy from your distribution instead of the built-in version then use
make NO_VENDOR_LIBS=1 when building git cola.  This will prevent
vendored libraries from being installed.









git-cola v2.6


Usability, bells and whistles


	A new “Reset” sub-menu provides access to running “git reset –mixed”
when resetting branch heads and “git reset  –merge” when resetting
worktrees.

https://github.com/git-cola/git-cola/issues/542



	git cola now supports linked worktrees, i.e. worktrees created by
git worktree.

https://github.com/git-cola/git-cola/issues/554








Fixes


	Diff highlighting is now robust to the user having
diff.supressBlankEmpty=true in their git config.

https://github.com/git-cola/git-cola/issues/541



	The filesystem monitor now properly handles repositories that use
.git-files, e.g. when using submodules.

https://github.com/git-cola/git-cola/issues/545

https://github.com/git-cola/git-cola/pulls/546



	Per-repository git configuration is now properly detected when launching
git cola from an application launcher.

https://github.com/git-cola/git-cola/issues/548



	git cola now cleans up after itself immediately to avoid leaving behind
empty /tmp/git-cola-XXXXXX directories when the user uses Ctrl+C
to quit the app.

https://github.com/git-cola/git-cola/issues/566








Packaging


	It is now possible to install git cola to and from utf8-encoded filesystem
paths.  Previously, Python’s stdlib would throw an encoding error during
installation.  We workaround the stdlib by forcing python2 to use utf-8,
thus fixing assumptions in the stdlib library code.

https://github.com/git-cola/git-cola/issues/551










git-cola v2.5


Usability, bells and whistles


	The icon for untracked files was adjusted to better differentiate
between files and the “Untracked” header.

https://github.com/git-cola/git-cola/issues/509



	Ctrl+O was added as a hotkey for opening repositories.

https://github.com/git-cola/git-cola/pull/507



	git dag now uses consistent edge colors across updates.

https://github.com/git-cola/git-cola/issues/512



	git cola’s Bookmarks widget can now be used to set a “Default Repository”.
Under the hood, we set the cola.defaultrepo configuration variable.
The default repository is used whenever git cola is launched outside of
a Git repository.  When unset, or when set to a bogus value, git cola
will prompt for a repository, as it previously did.

https://github.com/git-cola/git-cola/issues/513



	git cola’s Russian and Spanish translations were improved
thanks to Vaiz and Zeioth.

https://github.com/git-cola/git-cola/pull/514

https://github.com/git-cola/git-cola/pull/515

https://github.com/git-cola/git-cola/pull/523



	git cola was translated to Turkish thanks to Barış ÇELİK.

https://github.com/git-cola/git-cola/pull/520



	The status view now supports launching git gui blame.  It can be
configured to use a different command by setting cola.blameviewer.

https://github.com/git-cola/git-cola/pull/521



	git dag now allows selecting non-contiguous ranges in the log widget.

https://github.com/git-cola/git-cola/issues/468



	Any font can now be chosen for the diff editor, not just monospace fonts.

https://github.com/git-cola/git-cola/issues/525








Fixes


	xfce4-terminal and gnome-terminal are now supported when launching
git mergetool to resolve merges.  These terminals require that the command
to execute is shell-quoted and passed as a single string argument to -e
rather than as additional command line arguments.

https://github.com/git-cola/git-cola/issues/524



	Fixed a unicode problem when formatting the error message that is shown
when gitk is not installed.  We now handle unicode data in tracebacks
generated by python itself.

https://github.com/git-cola/git-cola/issues/528



	The New repository feature was fixed.

https://github.com/git-cola/git-cola/pull/533



	We now use omit the extended description when creating “fixup!” commits,
for consistency with the Git CLI.  We now include only the one-line summary
in the final commit message.

https://github.com/git-cola/git-cola/issues/522










git-cola v2.4


Usability, bells and whistles


	The user interface is now HiDPI-capable.  git-cola now uses SVG
icons, and its interface can be scaled by setting the GIT_COLA_SCALE
environment variable.


	git dag now supports the standard editor, difftool, and history hotkeys.
It is now possible to invoke these actions from file widget’s context
menu and through the standard hotkeys.

https://github.com/git-cola/git-cola/pull/473



	The Status tool also learned about the history hotkey.
Additionally, the Alt-{j,k} aliases are also supported in the Status
tool for consistency with the other tools where the non-Alt hotkeys are not
available.

https://github.com/git-cola/git-cola/pull/488



	The File Browser tool now has better default column sizes,
and remembers its window size and placement.


	The File Browser now supports the refresh hotkey, and has better
behavior when refreshing.  The selection is now retained, and new and
removed files are found when refreshing.


	A new git-cola-completion.bash completion script is provided in the
contrib/ directory.  It must be used alongside Git’s completion script.
Source it from your ~/.bashrc (or ~/.zshrc, etc) after sourcing
the git-completion.bash script and you will have command-line completion
support for the git cola and git dag sub-commands.


	The “checkout” dialog now offers completion for remote branches and other
git refs.  This makes it easier to checkout remote branches in a detached
head state.  Additionally, the checkout dialog also offers completion for
remote branches that have not yet been checked out, which makes it easier to
create a local tracking branch by just completing for that potential name.

https://github.com/git-cola/git-cola/issues/390



	The “create branch” and “create tag” dialogs now save and restore their
window settings.


	The “status” widget can now be configured to use a bold font with a darker
background for the header items.

https://github.com/git-cola/git-cola/pull/506



	The “status” widget now remembers its horizontol scrollbar position across
updates.  This is helpful when working on projects with long paths.

https://github.com/git-cola/git-cola/issues/494








Fixes


	When using Git for Windows, a git window would appear
when running Windows 8.  We now pass additional flags to
subprocess.Popen to prevent a git window from appearing.

https://github.com/git-cola/git-cola/issues/477

https://github.com/git-cola/git-cola/pull/486



	Launching difftool with .PY in $PATHEXT on Windows was fixed.

https://github.com/git-cola/git-cola/issues/492



	Creating a local branch tracking a remote branch that contains
slashes in its name is now properly handled.

https://github.com/git-cola/git-cola/issues/496



	The “Browse Other Branch” feature was broken by Python3, and is now fixed.

https://github.com/git-cola/git-cola/issues/501



	We now avoid long for better Python3 compatibility.

https://github.com/git-cola/git-cola/issues/502



	We now use Git’s default merge message when merging branches.

https://github.com/git-cola/git-cola/issues/508



	Miscellaneous fixes

https://github.com/git-cola/git-cola/pull/485








Packaging


	git-cola’s documentation no longer uses an intersphinx link mapping
to docs.python.org.  This fixes warnings when building rpms using koji,
where network access is prevented.

https://bugzilla.redhat.com/show_bug.cgi?id=1231812










git-cola v2.3


Usability, bells and whistles


	The Interactive Rebase feature now works on Windows!

https://github.com/git-cola/git-cola/issues/463



	The diff editor now understands vim-style hjkl navigation hotkeys.

https://github.com/git-cola/git-cola/issues/476



	Alt-{j,k} navigation hotkeys were added to allow changing to the
next/previous file from the diff and commit editors.


	The Rename branch menu action is now disabled in empty repositories.

https://github.com/git-cola/git-cola/pull/475

https://github.com/git-cola/git-cola/issues/459



	git cola now checks unmerged files for conflict markers before
staging them.  This feature can be disabled in the preferences.

https://github.com/git-cola/git-cola/issues/464



	git dag now remembers which commits were selected when refreshing
so that it can restore the selection afterwards.

https://github.com/git-cola/git-cola/issues/480



	“Launch Editor”, “Launch Difftool”, “Stage/Unstage”,
and “Move Up/Down” hotkeys now work when the commit message
editor has focus.

https://github.com/git-cola/git-cola/issues/453



	The diff editor now supports the Ctrl+u hotkey for reverting
diff hunks and selected lines.


	The core.commentChar Git configuration value is now honored.
Commit messages and rebase instruction sheets will now use
the configured character for comments.  This allows having
commit messages that start with # when core.commentChar
is configured to its non-default value.

https://github.com/git-cola/git-cola/issues/446








Fixes


	Diff syntax highlighting was improved to handle more edge cases
and false positives.

https://github.com/git-cola/git-cola/pull/467



	Setting commands in the interactive rebase editor was fixed.

https://github.com/git-cola/git-cola/issues/472



	git-cola no longer clobbers the Ctrl+Backspace text editing shortcut
in the commit message editor.

https://github.com/git-cola/git-cola/issues/453



	The copy/paste clipboard now persists after git cola exits.

https://github.com/git-cola/git-cola/issues/484










git-cola v2.2.1


Fixes


	Fixed the “Sign off” feature in the commit message editor.









git-cola v2.2


Usability, bells and whistles


	Double-click will now choose a commit in the “Select commit” dialog.


	git cola has a feature that reads .git/MERGE_MSG and friends for the
commit message when a merge is in-progress.  Upon refresh, git cola will
now detect when a merge has completed and reset the commit message back to
its previous state.  It is only reset if the editor contains a message
that was read from the file and has not been manually edited by the user.


	The commit message editor’s context menu now has a “Clear…” action for
clearing the message across both the summary and description fields.


	Traditional Chinese (Taiwan) translation updates.


	The system theme’s icons are now used wherever possible.

https://github.com/git-cola/git-cola/pull/458








Fixes


	The stash viewer now uses git show --no-ext-diff to avoid running
user-configured diff tools.


	git cola now uses the setsid() system call to ensure that the
GIT_ASKPASS and SSH_ASKPASS helper programs are used when pushing
changes using git.  The askpass helpers will now be used even when
git cola is launched from a terminal.

The behavior without setsid() is that git cola can appear to hang while
pushing changes.  The hang happens when git prompts the user for a
password using the terminal, but the user never sees the prompt.  setsid()
detaches the terminal, which ensures that the askpass helpers are used.

https://github.com/git-cola/git-cola/issues/218

https://github.com/git-cola/git-cola/issues/262

https://github.com/git-cola/git-cola/issues/377



	git dag’s file list tool was updated to properly handle unicode paths.


	gnome-terminal is no longer used by default when cola.terminal is unset.
It is broken, as was detailed in #456.

https://github.com/git-cola/git-cola/issues/456



	The interactive rebase feature was not always setting $GIT_EDITOR
to the value of gui.editor, thus there could be instances where rebase
will seem to not stop, or hang, when performing “reword” actions.

We now set the $GIT_EDITOR environment variable when performing the
“Continue”, “Skip”, and “Edit Todo” rebase actions so that the correct
editor is used during the rebase.

https://github.com/git-cola/git-cola/issues/445








Packaging


	git cola moved from a 3-part version number to a simpler 2-part “vX.Y”
version number.  Most of our releases tend to contain new features.









git-cola v2.1.2


Usability, bells and whistles


	Updated zh_TW translations.


	git cola rebase now defaults to @{upstream}, and generally uses the same
CLI syntax as git rebase.


	The commit message editor now allows you to bypass commit hooks by selecting
the “Bypass Commit Hooks” option.  This is equivalent to passing the
–no-verify option to git commit.

https://github.com/git-cola/git-cola/issues/357



	We now prevent the “Delete Files” action from creating a dialog that does
not fit on screen.

https://github.com/git-cola/git-cola/issues/378



	git xbase learned to edit rebase instruction sheets that contain
exec commands.


	The diff colors are now configurable.  cola.color.{text,add,remove,header}
can now be set with 6-digit hexadecimal colors.
See the git cola manual <https://git-cola.readthedocs.io/en/latest/git-cola.html#configuration-variables>_
for more details.


	Improved hotkey documentation.







Fixes


	git cola will now allow starting an interactive rebase with a dirty
worktree when rebase.autostash is set.

https://github.com/git-cola/git-cola/issues/360










git-cola v2.1.1


Usability, bells and whistles


	A new “Find files” widget was added, and can be activated by
using the Ctrl+t or t hotkeys.


	A new git cola find sub-command was added for finding files.


	git cola now remembers the text cursor’s position when staging
interactively with the keyboard.  This makes it easier to use the keyboard
arrows to select and stage lines.


	The completion widgets will now select the top completion item
when Enter or Return are pressed.


	You can now refresh using F5 in addition to the existing Ctrl+R hotkey.







Fixes


	git cola now passes –no-abbrev-commit to git log to override
having log.abbrevCommit = true set in .gitconfig.









git-cola v2.1.0


Usability, bells and whistles


	git dag now forwards all unknown arguments along to git log.

https://github.com/git-cola/git-cola/issues/389



	Line-by-line interactive staging was made more robust.

https://github.com/git-cola/git-cola/pull/399



	“Bookmarks” was renamed to “Favorites”.

https://github.com/git-cola/git-cola/issues/392



	Untracked files are now displayed using a unique icon.

https://github.com/git-cola/git-cola/pull/388








Fixes


	git dag was triggering a traceback on Fedora when parsing Git logs.

https://bugzilla.redhat.com/show_bug.cgi?id=1181686



	inotify expects unicode paths on Python3.

https://github.com/git-cola/git-cola/pull/393



	Untracked files are now assumed to be utf-8 encoded.

https://github.com/git-cola/git-cola/issues/401










git-cola v2.0.8


Usability, bells and whistles


	git cola can now create GPG-signed commits and merges.

https://github.com/git-cola/git-cola/issues/149

See the documentation for details about setting up a GPG agent.



	The status widget learned to copy relative paths when Ctrl+x is pressed.

https://github.com/git-cola/git-cola/issues/358



	Custom GUI actions can now define their own keyboard shortcuts by
setting guitool.$name.shortcut to a string understood by Qt’s
QAction::setShortcut() API, e.g. Alt+X.

See http://qt-project.org/doc/qt-4.8/qkeysequence.html#QKeySequence-2
for more details about the supported values.



	git cola learned to rename branches.

https://github.com/git-cola/git-cola/pull/364

https://github.com/git-cola/git-cola/issues/278



	git dag now has a “Show history” context menu which can be used to filter
history using the selected paths.







Fixes


	sphinxtogithub.py was fixed for Python3.

https://github.com/git-cola/git-cola/pull/353



	The commit that changed how we read remotes from git remote
to parsing git config was reverted since it created problems
for some users.


	Fixed a crash when using the rebase edit feature.

https://github.com/git-cola/git-cola/issues/351



	Better drag-and-drop behavior when dropping into gnome-terminal.

https://github.com/git-cola/git-cola/issues/373








Packaging


	The git-cola-folder-handler.desktop file handler was fixed
to pass validation by desktop-file-validate.

https://github.com/git-cola/git-cola/issues/356



	The git.svg icon was renamed to git-cola.svg, and git cola was taught
to prefer icons from the desktop theme when available.









git-cola v2.0.7


Usability, bells and whistles


	New hotkey: Ctrl+Shift+M merges branches.


	New hotkey: Ctrl+R refreshes the DAG viewer.

https://github.com/git-cola/git-cola/issues/347








Fixes


	We now use git config to parse the list of remotes
instead of parsing the output of git remote, which
is a Git porcelain and should not be used by scripts.


	Avoid “C++ object has been deleted” errors from PyQt4.

https://github.com/git-cola/git-cola/issues/346








Packaging


	The make install target now uses install instead of cp.









git-cola v2.0.6


Usability, bells and whistles


	Updated Brazillian Portuguese translation.


	The status and browse widgets now allow drag-and-drop into
external applications.

https://github.com/git-cola/git-cola/issues/335



	We now show a progress bar when cloning repositories.

https://github.com/git-cola/git-cola/issues/312



	The bookmarks widget was simplified to not need a
separate dialog.

https://github.com/git-cola/git-cola/issues/289



	Updated Traditional Chinese translation.


	We now display a warning when trying to rebase with uncommitted changes.

https://github.com/git-cola/git-cola/issues/338



	The status widget learned to filter paths.
Ctrl+Shift+S toggles the filter widget.

https://github.com/git-cola/git-cola/issues/337

https://github.com/git-cola/git-cola/pull/339



	The status widget learned to move files to the trash
when the send2trash [https://github.com/hsoft/send2trash]
module is installed.

https://github.com/git-cola/git-cola/issues/341



	“Recent repositories” is now a dedicated widget.

https://github.com/git-cola/git-cola/issues/342



	New Spanish translation thanks to Pilar Molina Lopez.

https://github.com/git-cola/git-cola/pull/344








Fixes


	Newly added remotes are now properly seen by the fetch/push/pull dialogs.

https://github.com/git-cola/git-cola/issues/343










git-cola v2.0.5


Usability, bells and whistles


	New Brazillian Portuguese translation thanks to Vitor Lobo.


	New Indonesian translation thanks to Samsul Ma’arif.


	Updated Simplified Chinese translation thanks to Zhang Han.


	Ctrl+Backspace is now a hotkey for “delete untracked files” in
the status widget.


	Fetch/Push/Pull dialogs now use the configured remote of the current
branch by default.

https://github.com/git-cola/git-cola/pull/324








Fixes


	We now use os.getcwd() on Python3.

https://github.com/git-cola/git-cola/pull/316

https://github.com/git-cola/git-cola/pull/326



	The Ctrl+P hotkey was overloaded to both “push” and “cherry-pick”,
so “cherry-pick” was moved to Ctrl+Shift+C.


	Custom GUI tools with mixed-case names are now properly supported.


	“Diff Region” is now referred to as “Diff Hunk” for consistency
with common terminology from diff/patch tools.

https://github.com/git-cola/git-cola/issues/328



	git-cola’s test suite is now portable to MS Windows.

https://github.com/git-cola/git-cola/pull/332










git-cola v2.0.4


Usability, bells and whistles


	We now handle the case when inotify add_watch() fails
and display instructions on how to increase the number of watches.

https://github.com/git-cola/git-cola/issues/263



	New and improved zh_TW localization thanks to Ｖ字龍(Vdragon).

https://github.com/git-cola/git-cola/pull/265

https://github.com/git-cola/git-cola/pull/267

https://github.com/git-cola/git-cola/pull/268

https://github.com/git-cola/git-cola/issues/269

https://github.com/git-cola/git-cola/pull/270

https://github.com/git-cola/git-cola/pull/271

https://github.com/git-cola/git-cola/pull/272



	New hotkeys: Ctrl+F for fetch, Ctrl+P for push,
and Ctrl+Shift+P for pull.


	The bookmarks widget’s context menu actions were made clearer.

https://github.com/git-cola/git-cola/issues/281



	The term “Staging Area” is used consistently in the UI
to allow for better localization.

https://github.com/git-cola/git-cola/issues/283



	The “Section” term is now referred to as “Diff Region”
in the UI.

https://github.com/git-cola/git-cola/issues/297



	The localization documentation related to the LANGUAGE
environment variable was improved.

https://github.com/git-cola/git-cola/pull/293



	The “Actions” panel now contains tooltips for each button
in case the button labels gets truncated by Qt.

https://github.com/git-cola/git-cola/issues/292



	Custom git config-defined actions can now be run in the
background by setting guitool.<name>.background to true.







Fixes


	We now use bold fonts instead of SmallCaps to avoid
artifacts on several configurations.


	We now pickup user.email, cola.tabwidth, and similar settings
when defined in /etc/gitconfig.

https://github.com/git-cola/git-cola/issues/259



	Better support for unicode paths when using inotify.

https://bugzilla.redhat.com/show_bug.cgi?id=1104181



	Unicode fixes for non-ascii locales.

https://github.com/git-cola/git-cola/issues/266

https://github.com/git-cola/git-cola/issues/273

https://github.com/git-cola/git-cola/issues/276

https://github.com/git-cola/git-cola/issues/282

https://github.com/git-cola/git-cola/issues/298

https://github.com/git-cola/git-cola/issues/302

https://github.com/git-cola/git-cola/issues/303

https://github.com/git-cola/git-cola/issues/305



	Viewing history from the file browser was fixed for Python3.

https://github.com/git-cola/git-cola/issues/274



	setup.py was fixed to install the *.rst documentation.

https://github.com/git-cola/git-cola/issues/279



	Patch export was fixed for Python3.

https://github.com/git-cola/git-cola/issues/290



	Fixed adding a bookmark with trailing slashes.

https://github.com/git-cola/git-cola/pull/295



	The default git dag layout is now setup so that its widgets
can be freely resized on Linux.

https://github.com/git-cola/git-cola/issues/299



	Invalid tag names are now reported when creating tags.

https://github.com/git-cola/git-cola/pull/296










git-cola v2.0.3


Usability, bells and whistles


	git cola no longer prompts after successfully creating a new branch.

https://github.com/git-cola/git-cola/pull/251



	Hitting enter on simple dialogs now accepts them.

https://github.com/git-cola/git-cola/pull/255








Fixes


	git dag no longer relies on sys.maxint, which is
not available in Python3.

https://github.com/git-cola/git-cola/issues/249



	Python3-related fixes.

https://github.com/git-cola/git-cola/pull/254



	Python3-on-Windows-related fixes.

https://github.com/git-cola/git-cola/pull/250

https://github.com/git-cola/git-cola/pull/252

https://github.com/git-cola/git-cola/pull/253



	Switching repositories using the bookmarks widget was not
refreshing the inotify watcher.

https://github.com/git-cola/git-cola/pull/256



	Special commit messages trailers (e.g. “Acked-by:”) are now special-cased to
fix word wrapping lines that start with “foo:”.

https://github.com/git-cola/git-cola/issues/257



	git dag sometimes left behind selection artifacts.
We now refresh the view to avoid them.

https://github.com/git-cola/git-cola/issues/204










git-cola v2.0.2


Usability, bells and whistles


	Better inotify support for file creation and deletion.

https://github.com/git-cola/git-cola/issues/240



	git cola now supports the X11 Session Management Protocol
and remembers its state across logout/reboot.

https://github.com/git-cola/git-cola/issues/164



	git cola has a new icon.

https://github.com/git-cola/git-cola/issues/190








Packaging


	Building the documentation no longer requires asciidoc.
We now use Sphinx [http://sphinx-doc.org/] for building
html documentation and man pages.







Fixes


	Reworked the git-dag gravatar icon code to avoid a unicode
error in Python 2.


	Commit message line-wrapping was made to better match the GUI editor.

https://github.com/git-cola/git-cola/issues/242



	Better support for Python3 on Windows

https://github.com/git-cola/git-cola/issues/246








Packaging


	git-cola no longer depends on Asciidoc for building its documentation
and man-pages.  We now depend on [Sphinx](http://sphinx-doc.org/) only.









git-cola v2.0.1


Usability, bells and whistles


	Some context menu actions are now hidden when selected
files do not exist.

https://github.com/git-cola/git-cola/issues/238








Fixes


	The build-git-cola.sh contrib script was improved.

https://github.com/git-cola/git-cola/pull/235



	Non-ascii worktrees work properly again.

https://github.com/git-cola/git-cola/issues/234



	The browser now guards itself against missing files.

https://bugzilla.redhat.com/show_bug.cgi?id=1071378



	Saving widget state now works under Python3.

https://github.com/git-cola/git-cola/pull/236










git-cola v2.0.0


Portability


	git-cola now runs on Python 3 thanks to Virgil Dupras.

https://github.com/git-cola/git-cola/pull/233



	Python 2.6, 2.7, and 3.2+ are now supported.
Python 2.5 is no longer supported.







Fixes


	i18n test fixes thanks to Virgil Dupras.

https://github.com/git-cola/git-cola/pull/231



	git-cola.app build fixes thanks to Maicon D. Filippsen.

https://github.com/git-cola/git-cola/pull/230



	Lots of pylint improvements thanks to Alex Chernetz.

https://github.com/git-cola/git-cola/pull/229










git-cola v1.9.4


Usability, bells and whistles


	The new Bookmarks tool makes it really easy to switch between repositories.


	There is now a dedicated dialog for applying patches.
See the File -> Apply Patches menu item.

https://github.com/git-cola/git-cola/issues/215



	A new git cola am sub-command was added for applying patches.







Fixes


	Fixed a typo that caused inotify events to be silently ignored.


	Fixed the sys.path setup for Mac OS X (Homebrew).

https://github.com/git-cola/git-cola/issues/221



	Lots of pylint fixes thanks to Alex Chernetz.









git-cola v1.9.3


Usability, bells and whistles


	git cola –amend now starts the editor in amend mode.

https://github.com/git-cola/git-cola/issues/187



	Multiple lines of text can now be pasted into the summary field.
All text beyond the first newline will be automatically moved to the
extended description field.

https://github.com/git-cola/git-cola/issues/212








Fixes


	Stray whitespace in .git files is now ignored.

https://github.com/git-cola/git-cola/issues/213



	Fix “known incorrect sRGB profile” in staged-item.png.

http://comments.gmane.org/gmane.linux.gentoo.devel/85066










git-cola v1.9.2


Fixes


	Fix a traceback when git push fails.

https://bugzilla.redhat.com/show_bug.cgi?id=1034778








Packaging


	Most of the git-cola sub-packages have been removed.
The only remaining packages are cola, cola.models,
and cola.widgets.


	The translation file for Simplified Chinese was renamed
to zh_CN.po.

https://github.com/git-cola/git-cola/issues/209










git-cola v1.9.1


Packaging


	git cola version –brief now prints the brief version number.







Fixes


	Resurrected the “make dist” target, for those that prefer to create
their own tarballs.


	Fixed the typo that broke the preferences dialog.









git-cola v1.9.0


Usability, bells and whistles


	We now ship a full-featured interactive git rebase editor.
The rebase todo file is edited using the git xbase script which
is provided at $prefix/share/git-cola/bin/git-xbase.
This script can be used standalone by setting the $GIT_SEQUENCE_EDITOR
before running git rebase –interactive.

https://github.com/git-cola/git-cola/issues/1



	Fixup commit messages can now be loaded from the commit message editor.


	Tool widgets can be locked in place by using the “Tools/Lock Layout”
menu action.

https://github.com/git-cola/git-cola/issues/202



	You can now push to several remotes simultaneously by selecting
multiple remotes in the “Push” dialog.

https://github.com/git-cola/git-cola/issues/148



	The grep tool learned to search using three different modes:
basic regular expressions (default), extended regular expressions,
and fixed strings.







Packaging


	git cola now depends on the argparse Python module.
This module is part of the stdlib in Python 2.7 and must
be installed separately when using Python 2.6 and below.







Fixes


	Support unicode in the output from fetch, push, and pull.









git-cola v1.8.5


Usability, bells and whistles


	We now detect when the editor or history browser are misconfigured.

https://github.com/git-cola/git-cola/issues/197

https://bugzilla.redhat.com/show_bug.cgi?id=886826



	Display of untracked files can be disabled from the Preferences dialog
or by setting the gui.displayuntracked configuration variable to false.

http://thread.gmane.org/gmane.comp.version-control.git/232683








Fixes


	Unicode stash names are now supported

https://github.com/git-cola/git-cola/issues/198



	The diffs produced when reverting workspace changes were made more robust.









git-cola v1.8.4


Usability, bells and whistles


	Brand new German translation thanks to Sven Claussner.


	The “File” menu now provides a “New Repository…” menu action.


	git dag now uses a dock-widget interface so that its widgets can
be laid-out and arranged.  Customizations are saved and restored
the next time git dag is launched.


	git dag now has a “Zoom Best Fit” button next alongside the
“Zoom In” and “Zoom Out” buttons.


	Ctrl+L now focuses the “Search” field in the git dag tool.


	Right-clicking in the “diff” viewer now updates the cursor position
before performing actions, which makes it much easier to click around
and selectively stage sections.  Previously, the current cursor position
was used which meant that it required two clicks (left-click to update
the position followed by right-click to get the context menu) for the
desired section to be used.  This is now a single right-click operation.


	The Ctrl+D “Launch Diff Tool” action learned to automatically choose
between git difftool and git mergetool.  If the file is unmerged then
we automatically launch git mergetool on the path, otherwise we use
git difftool.  We do this because git difftool is not intended to
be used on unmerged paths.  Automatically using git mergetool when
appropriate is the most intuitive and muscle-memory-friendly thing to do.


	You can now right-click on folders in your standard file browser
and choose “Open With -> Git Cola”  (Linux-only).







Fixes


	Python 2.6 on Mac OS X Snow Leopard does not provide a namedtuple
at sys.version_info.  We now avoid using that variable for better
portability.


	We now read the user’s Git configuration from ~/.config/git/config
if that file is available, otherwise we use the traditional ~/.gitconfig
path, just like Git itself.


	Some edge cases were fixed when applying partial/selected diffs.


	The diff viewer is now properly cleared when refreshing.

https://github.com/git-cola/git-cola/issues/194










git-cola v1.8.3


Usability, bells and whistles


	The diff viewer now has an “Options” menu which can be
used to set “git diff” options.  This can be used to
ignore whitespace changes or to show a change with its
surrounding function as context.

https://github.com/git-cola/git-cola/issues/150



	git cola now remembers your commit message and will restore it
when git cola is restarted.

https://github.com/git-cola/git-cola/pull/175



	Ctrl+M can now be used to toggle the “Amend last commit”
checkbox in the commit message editor.

https://github.com/git-cola/git-cola/pull/161



	Deleting remote branches can now be done from the “Branch” menu.

https://github.com/git-cola/git-cola/issues/152



	The commit message editor now has a built-in spell checker.







Fixes


	We now avoid invoking external diffs when showing diffstats.

https://github.com/git-cola/git-cola/pull/163



	The Status tool learned to reselect files when refreshing.

https://github.com/git-cola/git-cola/issues/165



	git cola now remembers whether it has been maximized and will restore the
maximized state when git cola is restarted.

https://github.com/git-cola/git-cola/issues/172



	Performance is now vastly improved when staging hundreds or
thousands of files.


	git cola was not correctly saving repo-specific configuration.

https://github.com/git-cola/git-cola/issues/174



	Fix a UnicodeDecode in sphinxtogithub when building from source.









git-cola v1.8.2


Usability, bells and whistles


	We now automatically remove missing repositories from the
“Select Repository” dialog.

https://github.com/git-cola/git-cola/issues/145



	A new git cola diff sub-command was added for diffing changed files.







Fixes


	The inotify auto-refresh feature makes it difficult to select text in
the “diff” editor when files are being continually modified by another
process.  The auto-refresh causes it to lose the currently selected text,
which is not wanted.  We now avoid this problem by saving and restoring
the selection when refreshing the editor.

https://github.com/git-cola/git-cola/issues/155



	More strings have been marked for l10n.

https://github.com/git-cola/git-cola/issues/157



	Fixed the Alt+D Diffstat shortcut.

https://github.com/git-cola/git-cola/issues/159








Fixes


	Better error handling when cloning repositories.

We were not handling the case where a git URL has
no basename, e.g. https://git.example.com/.
git cola originally rejected these URLs instead of
allowing users to clone them.  It now allows these URLs
when they point to valid git repositories.

Additionally, git cola learned to echo the errors
reported by git clone when it fails.

https://github.com/git-cola/git-cola/issues/156










git-cola v1.8.1


Usability, bells and whistles


	git dag got a big visual upgrade.


	Ctrl+G now launches the “Grep” tool.


	Ctrl+D launches difftool and Ctrl+E launches your editor
when in the diff panel.


	git-cola can now be told to use an alternative language.
For example, if the native language is German and we want git-cola to
use English then we can create a ~/.config/git-cola/language file with
“en” as its contents:

$ echo en >~/.config/git-cola/language

https://github.com/git-cola/git-cola/issues/140



	A new git cola merge sub-command was added for merging branches.


	Less blocking in the main UI







Fixes


	Autocomplete issues on KDE

https://github.com/git-cola/git-cola/issues/144



	The “recently opened repositories” startup dialog did not
display itself in the absence of bookmarks.

https://github.com/git-cola/git-cola/issues/139










git-cola v1.8.0


Usability, bells and whistles


	git cola learned to honor .gitattributes when showing and
interactively applying diffs.  This makes it possible to store
files in git using a non-utf-8 encoding and git cola will
properly accept them.  This must be enabled by settings
cola.fileattributes to true, as it incurs a small performance
penalty.

https://github.com/git-cola/git-cola/issues/96



	git cola now wraps commit messages at 72 columns automatically.
This is configurable using the cola.linebreak variable to enable/disable
the feature, and cola.textwidth to configure the limit.

https://github.com/git-cola/git-cola/issues/133



	A new “Open Recent” sub-menu was added to the “File” menu.
This makes it easy to open a recently-edited repository.

https://github.com/git-cola/git-cola/issues/135



	We now show a preview for untracked files when they are clicked
using the Status tool.


	A new “Open Using Default Application” action was added to the
Status tool.  It is activated using either Spacebar or through
the context menu.  This action uses xdg-open on Linux and
open on Mac OS X.


	A new “Open Parent Directory” action was added to the Status tool.
It is activated using either Shift+Spacebar or through the
context menu.


	git dag learned to honor the log.date git configuration variable.
This makes the date display follow whatever format the user has
configured.


	A new git cola config sub-command was added for quickly
tweaking git cola’s git configuration settings.


	Some small usability tweaks – some user confirmation prompts
were defaulting to “Cancel” when they should have been defaulting
to the affirmative option instead.







Fixes


	Properly handle arbitrarily-named branches.


	We went back to launching git mergetool using an xterm.
The reason is that there are a couple of places where git mergetool
requires a terminal for user interaction not covered by –no-prompt.


	We now properly handle an edge case when applying short diffs at
the start of a file.









git-cola v1.7.7


Usability, bells and whistles


	New and improved grep mode lets you instantly find and edit files.


	New git cola grep standalone mode.


	Support for passing arguments to the configured editors, e.g. gvim -p
This makes it possible to select multiple files in the status
window and use Ctrl-e to edit them all at once.


	Remote operations now prompt on errors only.


	The Tab key now jumps to the extended description when editing the summary.


	More shortcut key labels and misc. UX improvements.







Fixes


	Selecting an item no longer copies its filename to the copy/paste buffer.
Ctrl-c or the “Copy” context-menu action can be used instead.


	The repository monitoring feature on Windows learned to ignore
changes within the “.git” directory.  Thanks to Andreas Sommer.

https://github.com/git-cola/git-cola/issues/120










git-cola v1.7.6


Usability, bells and whistles


	git dag learned to color-code branchy edges.
The edge colors change when a new branch is detected,
which makes the history much easier to follow.
A huge thanks to Uri Okrent for making it happen.


	New GUI for editing remote repositories.


	New git cola archive and git cola remote sub-commands.


	git cola browser learned an ‘Untrack’ command.


	The diff editor learned to staged/unstaged while amending.


	The status tool can now scroll horizontally.


	New git repositories can be created by clicking ‘New’ on the
git cola –prompt startup screen.









git-cola v1.7.5


Usability, bells and whistles


	Auto-completion was added to more tools.


	git dag is easier to use on smaller displays – the author
field elides its text which allows for a more compact display.


	Selected commits in git dag were made more prominent and
easier to see.


	‘Create Branch’ learned to fetch remote branches and uses a
background thread to do so.


	User-configured GUI tools are listed alphabetically in the ‘Actions’ menu.


	The ‘Pull’ dialog remembers the value of the ‘Rebase’ checkbox
between invocations.









git-cola v1.7.4.1


Fixes


	Detect Homebrew so that OS X users do not need to set PYTHONPATH.


	git dag can export patches again.









git-cola v1.7.4


Usability, bells and whistles


	The ‘Classic’ tool was renamed to ‘Browser’ and learned to
limit history to the current branch.


	git dag learned about gravatar and uses it to show images
for commit authors.


	git dag learned to use OpenGL for rendering resulting in
much faster rendering.


	More dialogs learned vim-style keyboard shortcuts.


	The commit message editor learned better arrow key navigation.









git-cola v1.7.3


Usability, bells and whistles


	git cola learned a few new sub commands:




git cola dag
git cola branch
git cola search






	Return in the summary field jumps to the extended description.


	Ctrl+Return is now a shortcut for ‘Commit’.


	Better French translation for ‘Sign-off’.


	The ‘Search’ widget now has a much simpler and streamlined
user interface.


	vim-style h,j,k,l navigation shortcuts were added to the DAG widget.


	git dag no longer prompts for files when diffing commits if the
text field contains paths.


	General user interface and performance improvements.







Fixes


	The diff viewer no longer changes font size when holding Control
while scrolling with the mouse wheel.


	Files with a typechange (e.g. symlinks that become files, etc.)
are now correctly identified as being modified.







Packaging


	The cola.controllers and cola.views packages were removed.









git-cola v1.7.2


Usability, bells and whistles


	git cola can now launch sub commands, e.g.:




git cola classic
git cola stash
git cola fetch
git cola push
git cola pull
git cola tag






	git dag is more responsive when gathering auto-completions.


	Keyboard shortcuts are displayed when the ‘?’ key is pressed.


	Various keyboard shortcuts were added for improved usability.


	The status widget now lists unmerged files before modified files.


	vim-style h,j,k,l navigation shortcuts were added to the status widget.


	A ‘Recently Modified Files…’ tool was added.


	Tools can now be hidden with Alt + # (where # is a keyboard number)
and focused with Alt + Shift + #.


	The syntax highlighting colors for diffs was made less intrusive.


	The commit message editor was redesigned to have a more compact
and keyboard-convenient user interface.


	Keyboard shortcuts for adding a Signed-off-by (Ctrl + i)
and creating a commit (Ctrl + m) were added.


	The status widget was adjusted to use less screen real-estate.







Fixes


	Avoid updating the index when responding to inotify events.
This avoids interfering with operations such as git rebase –interactive.

https://github.com/git-cola/git-cola/issues/99








Packaging


	Create git-dag.pyw in the win32 installer.


	win32 shortcuts now contain explicit calls to pythonw.exe instead of
calling the .pyw file directly.







Deprecated Features


	The ‘Apply Changes from Branch…’ feature was removed.
git dag’s ‘Grab File…’ feature used alongside the index/worktree editor
is a simpler alternative.









git-cola v1.7.1.1


Fixes


	Further enhanced the staging/unstaging behavior in the status widget.

https://github.com/git-cola/git-cola/issues/97



	Unmerged files are no longer listed as modified.







Packaging

The cola-$version tarballs on github were originally setup to
have the same contents as the old tarballs hosted on tuxfamily.
The make dist target was changed to write files to a
git-cola-$version subdirectory and tarball.

This makes the filenames consistent for the source tarball,
the darwin .app tarball, and the win32 .exe installer.






git-cola v1.7.1


Usability, bells and whistles


	Refined the staging/unstaging behavior for code reviews.

https://github.com/git-cola/git-cola/issues/97



	Added more styling and icons to menus and buttons.


	Adjusted some terminology to more closely match the git CLI.







Fixes


	Boolean git config settings with no value are now supported
(these are not created by git these days but exist in legacy repositories).


	Unicode branches and tags are supported in the “branch diff” tool.


	Guard against low-memory conditions and more interrupted system calls.







Packaging


	Added desktop launchers for git-cola.desktop and git-dag.desktop.
This replaces the old cola.desktop, so some adjustments to RPM .spec
and debian/ files will be needed.


	Fixed the darwin app-tarball Makefile target to create relative paths.







Cleanup


	The –style option was removed.  git cola follows the system theme
so there’s no need for this option these days.









git-cola v1.7.0


Usability, bells and whistles


	Export a patch series from git dag into a patches/ directory.


	git dag learned to diff commits, slice history along paths, etc.


	Added instant-preview to the git stash widget.


	A simpler preferences editor is used to edit git config values.

https://github.com/git-cola/git-cola/issues/90

https://github.com/git-cola/git-cola/issues/89



	Previous commit messages can be re-loaded from the message editor.

https://github.com/git-cola/git-cola/issues/33








Fixes


	Display commits with no file changes.

https://github.com/git-cola/git-cola/issues/82



	Improved the diff editor’s copy/paste behavior

https://github.com/git-cola/git-cola/issues/90








Packaging


	Bumped version number to ceil(minimum git version).
git cola now requires git >= 1.6.3.


	Simplified git-cola’s versioning when building from tarballs
outside of git.  We no longer check for a ‘version’ file at
the root of the repository.  We instead keep a default version
in cola/version.py and use it when git cola’s .git repository
is not available.









git-cola v1.4.3.5


Usability, bells and whistles


	inotify is much snappier and available on Windows
thanks to Karl Bielefeldt.


	New right-click command to add untracked files to .gitignore
thanks to Audrius Karabanovas.


	Stash, fetch, push, and pull usability improvements


	General usability improvements


	stderr is logged when applying partial diffs.







Fixes


	Files can be unstaged when amending.

https://github.com/git-cola/git-cola/issues/82



	Show the configured remote.$remote.pushurl in the GUI

https://github.com/git-cola/git-cola/issues/83



	Removed usage of the “user” module.

https://github.com/git-cola/git-cola/issues/86



	Avoids an extra git update-index call during startup.









git-cola v1.4.3.4


Usability, bells and whistles


	We now provide better feedback when git push fails.

https://github.com/git-cola/git-cola/issues/69



	The Fetch, Push, and Pull dialogs now give better feedback
when interacting with remotes.  The dialogs are modal and
a progress dialog is used.







Fixes


	More unicode fixes, again.  It is now possible to have
unicode branch names, repository paths, home directories, etc.
This continued the work initiated by Redhat’s bugzilla #694806.

https://bugzilla.redhat.com/show_bug.cgi?id=694806










git-cola v1.4.3.3


Usability, bells and whistles


	The git cola desktop launchers now prompt for a repo
by default.  This is done by using the new –prompt
flag which tells git cola to ignore any git repositories
in the current directory and prompt for one instead.







Fixes


	More Unicode fixes for repositories and home directories with
embedded unicode characters.  Thanks to Christian Jann for
patience and helpful bug reports.


	Fix the ‘Clone’ button in the startup dialog.









git-cola v1.4.3.2


Usability, bells and whistles


	Faster startup time! git cola now offloads initialization
to a background thread so that the GUI appears almost instantly.


	Specialized diff options for p4merge, vimdiff, araxis, emerge,
and ecmerge in difftool (backported from git.git).







Fixes


	Fix launching commands in the background on Windows
(e.g. when launching git difftool).


	Fix unicode errors when home or repository directories contain
unicode characters.

https://github.com/git-cola/git-cola/issues/74

Redhat’s bugzilla #694806

https://bugzilla.redhat.com/show_bug.cgi?id=694806










git-cola v1.4.3.1


Usability, bells and whistles


	The cola classic tool can be now configured to be dockable.

https://github.com/git-cola/git-cola/issues/56



	The cola classic tool now uses visual sigils to indicate a file’s status.
The idea and icons were provided by Uri Okrent.


	Include the ‘Rescan’ button in the ‘Actions’ widget regardless
of whether inotify is installed.







Packaging


	Fix installation of translations per Fedora
This incorporates Fedora’s fix for the translations path
which originally appeared in cola-1.4.3-translations.patch.


	Mac OS X git-cola developers can now generate git-cola.app
application bundles using ‘make app-bundle’.







Fixes


	Fixed a stacktrace when trying to use “Get Commit Message Template”
with an unconfigured “commit.template” git config variable.

https://github.com/git-cola/git-cola/issues/72

This bug originated in Redhat’s bugzilla #675721 via a Fedora user.

https://bugzilla.redhat.com/show_bug.cgi?id=675721



	Properly raise the main window on Mac OS X.


	Properly handle staging a huge numbers of files at once.


	Speed up ‘git config’ usage by fixing cola’s caching proxy.


	Guard against damaged ~/.cola files.









git-cola v1.4.3


Usability, bells and whistles


	git dag now has a separate display area
for displaying commit metadata.  This area will soon
grow additional functionality such as cherry-picking,
branching, etc.







Fixes


	Fixed tests from a previous refactoring.


	Guard against ‘diff.external’ configuration by always
calling ‘git diff’ with the ‘–no-ext-diff’ option.

https://github.com/git-cola/git-cola/issues/67



	Respect ‘gui.diffcontext’ so that cola’s diff display
shows the correct number of context lines.


	Raise the GUI so that it is in the foreground on OS X.







Packaging


	We now allow distutils to rewrite cola’s shebang line.
This allows us to run on systems where “which python”
is Python3k.  This is exposed by setting the PYTHON
Makefile variable to the location of python2.x.


	git-cola.app is now a tiny download because it no longer
contains Qt and PyQt.  These libraries are provided as a
separate download.

http://code.google.com/p/git-cola/downloads/list










git-cola v1.4.2.5


Usability, bells and whistles


	Clicking on paths in the status widget copies them into the
copy/paste buffer for easy middle-clicking into terminals.


	Ctrl+C in diff viewer copies the selected diff to the clipboard.







Fixes


	Fixed the disappearing actions buttons on PyQt 4.7.4
as reported by Arch and Ubuntu 10.10.

https://github.com/git-cola/git-cola/issues/62



	Fixed mouse interaction with the status widget where some
items could not be de-selected.







Packaging


	Removed hard-coded reference to lib/ when calculating Python’s
site-packages directory.









git-cola v1.4.2.4


Usability, bells and whistles


	Removed “single-click to (un)stage” in the status view.
This is a usability improvement since we no longer perform
different actions depending on where a row is clicked.


	Added ability to create unsigned, annotated tags.







Fixes


	Updated documentation to use cola.git instead of cola.gitcmd.









git-cola v1.4.2.3


Usability, bells and whistles


	Allow un/staging by right-clicking top-level items

https://github.com/git-cola/git-cola/issues/57



	Running ‘commit’ with no staged changes prompts to allow
staging all files.

https://github.com/git-cola/git-cola/issues/55



	Fetch, Push, and Pull are now available via the menus

https://github.com/git-cola/git-cola/issues/58








Fixes


	Simplified the actions widget to work around a regression
in PyQt4 4.7.4.

https://github.com/git-cola/git-cola/issues/62










git-cola v1.4.2.2


Usability, bells and whistles


	git dag interaction was made faster.







Fixes


	Added ‘…’ indicators to the buttons for
‘Fetch…’, ‘Push…’, ‘Pull…’, and ‘Stash…’.

https://github.com/git-cola/git-cola/issues/51



	Fixed a hang-on-exit bug in the cola-provided
‘ssh-askpass’ implementation.









git-cola v1.4.2.1


Usability, bells and whistles


	Staging and unstaging is faster.

https://github.com/git-cola/git-cola/issues/48



	git dag reads history in a background thread.







Portability


	Added cola.compat.hashlib for Python 2.4 compatibility


	Improved PyQt 4.1.x compatibility.







Fixes


	Configured menu actions use sh -c for Windows portability.









git-cola v1.4.2


Usability, bells and whistles


	Added support for the configurable guitool.<tool>.*
actions as described in git-config(1).

https://github.com/git-cola/git-cola/issues/44

http://schacon.github.com/git/git-config.html

This makes it possible to add new actions to git cola
by simply editing ~/.gitconfig.  This implements the
same guitool support as git gui.



	Introduced a stat cache to speed up git config and
repository status checks.


	Added Alt-key shortcuts to the main git cola interface.


	The Actions dock widget switches between a horizontal
and vertical layout when resized.


	We now use git diff --submodule for submodules
(used when git >= 1.6.6).


	The context menu for modified submodules includes an option
to launch git cola.

https://github.com/git-cola/git-cola/issues/17



	Prefer $VISUAL over $EDITOR when both are defined.
These are used to set a default editor in lieu of core.editor
configuration.


	Force the editor to be gvim when we see vim.
This prevents us from launching an editor in the (typically
unattached) parent terminal and creating zombie editors
that cannot be easily killed.


	Selections are remembered and restored across updates.
This makes the partial-staging workflow easier since the
diff view will show the updated diff after staging.


	Show the path to the current repository in a tooltip
over the commit message editor.

https://github.com/git-cola/git-cola/issues/45



	Log internal git commands when GIT_COLA_TRACE is defined.

https://github.com/git-cola/git-cola/issues/39








Fixes


	Improved backwards compatibility for Python 2.4.


	Review mode can now review the current branch; it no longer
requires you to checkout the branch into which the reviewed
branch will be merged.


	Guard against color.ui = always configuration when using
git log by passing --no-color.


	yes and no are now supported as valid booleans
by the git config parser.


	Better defaults are used for fetch, push, and pull..

https://github.com/git-cola/git-cola/issues/43








Packaging


	Removed colon (:) from the applilcation name on Windows

https://github.com/git-cola/git-cola/issues/41



	Fixed bugs with the Windows installer

https://github.com/git-cola/git-cola/issues/40



	Added a more standard i18n infrastructure.  The install
tree now has the common share/locale/$lang/LC_MESSAGES/git-cola.mo
layout in use by several projects.


	Started trying to accommodate Mac OSX 10.6 (Snow Leopard)
in the darwin/ build scripts but our tester is yet to
report success building a .app bundle.


	Replaced use of perl in Sphinx/documentation Makefile
with more-portable sed constructs.  Thanks to
Stefan Naewe for discovering the portability issues and
providing msysgit-friendly patches.









git-cola v1.4.1.2


Usability, bells and whistles


	It is now possible to checkout from the index as well
as from HEAD.  This corresponds to the
Removed Unstaged Changes action in the Repository Status tool.


	The remote dialogs (fetch, push, pull) are now slightly
larger by default.


	Bookmarks can be selected when git cola is run outside of a git repository.


	Added more user documentation.  We now include many links to
external git resources.


	Added git dag to the available tools.
git dag is a node-based DAG history browser.
It doesn’t do much yet, but it’s been merged so that we can start
building and improving upon it.







Fixes


	Fixed a missing import when showing right-click actions
for unmerged files in the Repository Status tool.


	git update-index --refresh is no longer run every time
git cola version is run.


	Don’t try to watch non-existent directories when using inotify.


	Use git rev-parse --symbolic-full-name plumbing to find
the name of the current branch.







Packaging


	The Makefile will now conditionally include a config.mak
file located at the root of the project.  This allows for user
customizations such as changes to the prefix variable
to be stored in a file so that custom settings do not need to
be specified every time on the command-line.


	The build scripts no longer require a .git directory to
generate the builtin_version.py module.  The release tarballs
now include a version file at the root of the project which
is used in lieu of having the git repository available.
This allows for make clean && make to function outside of
a git repository.


	Added maintainer’s make dist target to the Makefile.


	The built-in simplejson and jsonpickle libraries can be
excluded from make install by specifying the standalone=true
make variable.  For example, make standalone=true install.
This corresponds to the --standalone option to setup.py.









git-cola v1.4.1.1


Usability, bells and whistles


	We now use patience diff by default when it is available via
git diff –patience.


	Allow closing the cola classic tool with Ctrl+W.







Fixes


	Fixed an unbound variable error in the push dialog.







Packaging


	Don’t include simplejson in MANIFEST.in.


	Update desktop entry to read Cola Git GUI.









git-cola v1.4.1

This feature release adds two new features directly from
git cola’s github issues backlog.  On the developer
front, further work was done towards modularizing the code base.


Usability, bells and whistles


	Dragging and dropping patches invokes git am

https://github.com/git-cola/git-cola/issues/3



	A dialog to allow opening or cloning a repository
is presented when git cola is launched outside of a git repository.

https://github.com/git-cola/git-cola/issues/22



	Warn when push is used to create a new branch

https://github.com/git-cola/git-cola/issues/35



	Optimized startup time by removing several calls to git.







Portability


	git cola is once again compatible with PyQt 4.3.x.







Developer


	cola.gitcmds was added to factor out git command-line utilities


	cola.gitcfg was added for interacting with git config


	cola.models.browser was added to factor out repobrowser data


	Added more tests









git-cola v1.4.0.5


Fixes


	Fix launching external applications on Windows


	Ensure that the amend checkbox is unchecked when switching modes


	Update the status tree when amending commits









git-cola v1.4.0.4


Packaging


	Fix Lintian warnings









git-cola v1.4.0.3


Fixes


	Fix X11 warnings on application startup









git-cola v1.4.0.2


Fixes


	Added missing ‘Exit Diff Mode’ button for ‘Diff Expression’ mode

https://github.com/git-cola/git-cola/issues/31



	Fix a bug when initializing fonts on Windows

https://github.com/git-cola/git-cola/issues/32










git-cola v1.4.0.1


Fixes


	Keep entries in sorted order in the cola classic tool


	Fix staging untracked files

https://github.com/git-cola/git-cola/issues/27



	Fix the show command in the Stash dialog

https://github.com/git-cola/git-cola/issues/29



	Fix a typo when loading merge commit messages

https://github.com/git-cola/git-cola/issues/30










git-cola v1.4.0

This release focuses on a redesign of the git-cola user interface,
a tags interface, and better integration of the cola classic tool.
A flexible interface based on configurable docks is used to manage the
various cola widgets.


Usability, bells and whistles


	New GUI is flexible and user-configurable


	Individual widgets can be detached and rearranged arbitrarily


	Add an interface for creating tags


	Provide a fallback SSH_ASKPASS implementation to prompt for
SSH passwords on fetch/push/pull


	The commit message editor displays the current row/column and
warns when lines get too long


	The cola classic tool displays upstream changes


	git cola –classic launches cola classic in standalone mode


	Provide more information in log messages







Fixes


	Inherit the window manager’s font settings


	Miscellaneous PyQt4 bug fixes and workarounds







Developer


	Removed all usage of Qt Designer .ui files


	Simpler model/view architecture


	Selection is now shared across tools


	Centralized notifications are used to keep views in sync


	The cola.git command class was made thread-safe


	Less coupling between model and view actions


	The status view was rewritten to use the MVC architecture


	Added more documentation and tests









git-cola v1.3.9


Usability, bells and whistles


	Added a cola classic tool for browsing the entire repository


	Handle diff expressions with spaces


	Handle renamed files







Portability


	Handle carat ^ characters in diff expressions on Windows


	Worked around a PyQt 4.5/4.6 QThreadPool bug







Documentation


	Added a keyboard shortcuts reference page


	Added developer API documentation







Fixes


	Fix the diff expression used when reviewing branches


	Fix a bug when pushing branches


	Fix X11 warnings at startup


	Fix more interrupted system calls on Mac OS X









git-cola v1.3.8


Usability, bells and whistles


	Fresh and tasty SVG logos


	Added Branch Review mode for reviewing topic branches


	Added diff modes for diffing between tags, branches,
or arbitrary git diff expressions


	The push dialog selects the current branch by default.
This is in preparation for git 1.7.0 where unconfigured git push
will refuse to push when run without specifying the remote name
and branch.  See the git release notes for more information


	Support open and clone commands on Windows


	Allow saving cola UI layouts


	Re-enabled double-click-to-stage for unmerged entries.
Disabling it for unmerged items was inconsistent, though safer.


	Show diffs when navigating the status tree with the keyboard







Packaging


	Worked around pyuic4 bugs in the setup.py build script


	Added Mac OSX application bundles to the download page









git-cola v1.3.7


Subsystems


	git difftool became an official git command in git 1.6.3.


	git difftool learned –no-prompt / -y and a corresponding
difftool.prompt configuration variable







Usability, bells and whistles


	Warn when non-fast-forward is used with fetch, push or pull


	Allow Ctrl+C to exit cola when run from the command line







Fixes


	Support Unicode font names


	Handle interrupted system calls







Developer


	PEP-8-ified more of the cola code base


	Added more tests







Packaging


	All resources are now installed into $prefix/share/git-cola.
Closed Debian bug #519972

http://bugs.debian.org/cgi-bin/bugreport.cgi?bug=519972










git-cola v1.3.6


Subsystems


	Added support for Kompare in git difftool


	Added a separate configuration namespace for git difftool


	Added the diff.tool configuration variable to define the default diff tool







Usability, bells and whistles


	The stash dialog allows passing the –keep-index option to git stash


	Amending a published commit warns at commit time


	Simplified the file-across-revisions comparison dialog


	origin is selected by default in fetch/push/pull


	Removed the search field from the log widget


	The log window moved into a drawer widget at the bottom of the UI


	Log window display can be configured with
cola.showoutput = {never, always, errors}.  errors is the default.


	NOTE – cola.showoutput was removed with the GUI rewrite in 1.4.0.







Developer


	Improved nose unittest usage







Packaging


	Added a Windows/msysGit installer


	Included private versions of simplejson and jsonpickle
for ease of installation and development
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